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ÖZET 

Fetus Kadavralarında Canalis Carpi’nin Anatomik Yapısının İncelenmesi 

Bu çalışma; fetus kadavralarında, el ve el bileğinin antropometrik özellikleri ile 

canalis carpi’nin anatomik yapısının incelenmesi amacıyla planlandı. Çalışmada; Anatomi 

Anabilim Dalı laboratuvarında mevcut olan, %10’luk formaldehit çözeltisi içerisinde 

muhafaza edilmiş, intrauterin yaşları 21.2 ile 39.2 hafta arasında değişen 35 adet fetus 

kadavrasının el ve el bileği bölgesi incelendi. Fetus kadavralarının el ve el bileğine ait 

antropometrik ölçümler yapıldı. Canalis carpi’nin sınırlarını belirlemek için el bileği ve 

elin palmar yüzü klasik anatomik diseksiyon yöntemleri ile diseke edildi. Canalis carpi’nin 

seviyesi belirlendikten sonra bu seviyeden giyotin ile transvers kesit elde edildi. Açığa 

çıkan tüm transvers kesitlerden dijital fotoğraf makinesi ile görüntü alındı. ImageJ yazılımı 

kullanılarak canalis carpi’nin genişliği, yüksekliği, enine kesit alanı; nervus medianus’un 

enine kesit alanı, fleksor tendonların enine kesit alanı ile ilgili ölçümler ve hesaplamalar 

yapıldı. Fetuslar cinsiyetlerine, intrauterin yaşlarına, nöral tüp defekti varlığına ve 

lateralizasyona göre gruplandırıldı. Hesaplamalar sonucunda elde edilen sayısal değerler 

gruplar arasında karşılaştırıldı. Yapılan karşılaştırmalar sonucunda bazı farklılıklar 

bulundu.  

Çalışmamızda elde edilen bulgulara göre; canalis carpi anatomisinin ve doğuştan 

gelen anatomik özelliklerin karpal tünel sendromu gelişimine katkıda bulunabileceği 

sonucuna varılmıştır. Canalis carpi’nin anatomisin iyi bilinmesi, karpal tünel sendromunun 

etiyolojisinin ve patogenezinin anlaşılmasına ve tedavi stratejilerinin geliştirilmesine katkı 

sağlayacaktır. 

Anahtar Sözcükler: Anatomi, El bileği, Fetus kadavrası, Karpal tünel sendromu, Periferik 

nöropati 
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ABSTRACT 

Examination of the Anatomical Structure of Canalis Carpi on Fetus Cadavers 

This study was planned to investigate the anthropometric features of the hand and 

wrist and the anatomical structure of the canalis carpi on fetus cadavers. In this study, the 

hand and wrist regions of 35 fetus cadavers with intrauterin ages ranging between 21.2 and 

39.2 weeks that had been embalmed in 10% formaldehyde solution in the laboratory of 

Anatomy Department were examined. Anthropometric measurements of fetus cadavers 

were performed on the wrist and hand. To determine the borders of the canalis carpi, the 

wrist and palmar face of the hand were dissected with classical anatomical dissection 

methods. After determining the level of canalis carpi, transverse section was obtained with 

guillotine from this level. All exposed transverse sections were imaged with a digital 

camera. ImageJ software was used to measure and calculate the width, height, cross-

sectional area of the canalis carpi; cross-sectional area of the nervus medianus, and cross-

sectional area of the flexor tendons. Fetuses were grouped according to gender, intrauterine 

age, presence of neural tube defect and lateralization. The numerical values obtained from 

the calculations were compared between the groups. As a result of the comparisons, some 

differences were found. 

According to the findings obtained in our study; it was concluded that canalis carpi 

anatomy and innate anatomical features may contribute to the development of carpal tunnel 

syndrome (CTS). A thorough understanding of the anatomy of the canalis carpi will 

contribute to an understanding of the etiology and pathogenesis of CTS and the 

development of therapeutic strategies. 

Keywords: Anatomy, Carpal tunnel syndrome, Fetus cadaver, Peripheral neuropathy, 

Wrist 
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1. GİRİŞ ve AMAÇ 

Canalis carpi lateralde os scaphoideum ve os trapezium, medialde hamulus ossis 

hamati ve os pisiforme ile sınırlandırılan; tavanı lig. carpi transversum ile örtülü 

osteofibröz bir kanaldır. Canalis carpi’den n. medianus ile fleksor kasların tendonları geçer 

(1, 2). Karpal tünel sendromu (KTS); n. medianus’un canalis carpi’den geçerken lig. carpi 

transversum’un altında sıkışmasıyla oluşan, üst ekstremitenin en sık karşılaşılan periferik 

nöropatisidir (3). Genel populasyonda prevalansı yaklaşık %3-5 olarak bildirilmiştir. 

Kadınlarda erkeklere göre daha sık görülür. Karpal tünel sendromunda dominant el fazla 

kullanıma bağlı olarak daha erken ve daha şiddetli olarak tutulsa da vakaların yaklaşık 

%60’ında bilateral etkilenim görülmektedir (4). 

Karpal tünel sendromunun tanısı hastanın öyküsü, fizik muayene bulguları ve 

elektronörofizyolojik testlerin sonuçları eşliğinde konulur. En sık rastlanılan semptomlar; 

n. medianus’un inerve ettiği alanda özellikle geceleri oluşan veya artan ağrı, uyuşma, 

karıncalanma ve duyu kaybıdır. Geç dönemde thenar bölgede güçsüzlük ve kas atrofisi ile 

fonksiyon ve beceri kaybı görülür (5, 6). 

Karpal tünel sendromunun etiyolojisi tam olarak bilinmemektedir ve vakaların çoğu 

idiyopatiktir. Yapılan çalışmalarda el ve el bileğinin tekrarlı aktiviteleri, mesleki faktörler, 

obezite, kadın cinsiyet, artan yaş, anatomik yapı gibi kişisel özellikler ile diabetus mellitus, 

tiroid fonksiyon bozuklukları, romatoid artrit, osteoartrit gibi metabolik ve sistemik 

hastalıklar KTS ile ilişkilendirilmiştir (5). Son zamanlardaki araştırmalar gebelik, 

konnektif doku değişiklikleri, ailesel yatkınlık gibi etiyolojik faktörlerin üzerinde 

yoğunlaşmıştır (7, 8). 

Canalis carpi’nin anatomik varyasyonlarının KTS için hazırlayıcı faktörlerden 

olduğu ortaya konulmuştur. Sinir, kas ve tendonlara ait varyasyonların KTS oluşumunda 

rol oynadığını bildiren çalışmalar da mevcuttur (9). Karpal tünel sendromunun patogenezi 

henüz tam olarak aydınlatılamamıştır. Özellikle el bileğinin uzun süreli ve tekrarlı 

fleksiyon ve ekstansiyon hareketleri canalis carpi içindeki fleksor tendonlarda ve sinoviyal 

kılıflarında hipertrofiye neden olmaktadır. Tekrarlayan hareketler ile tendonların ve 

sinoviyal kılıflarının kalınlaşması canalis carpi içerisinde kapladıkları alanı artırmakta, 

dolayısı ile tünel içi basınç da artmaktadır. Tünel içi basınç artışının ve n.medianus’un 

kompresyonunun canalis carpi’nin şekli ve boyutu gibi anatomik ve morfolojik özellikleri 

ile ilişkili olduğu bildirilmiştir (10, 11).  
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Karpal tünel sendromu toplumda oldukça yaygın görülen, modern yaşamın ve 

teknolojinin getirdiği koşullarla birlikte giderek artan prevelansa sahip olan bir sağlık 

problemidir. Tedavi edilmediğinde n. medianus’un geri dönüşümsüz hasarına bağlı olarak 

iş gücünde kayıplara neden olabilmektedir. Aynı zamanda fonksiyonel kayıplar ile 

hastaların günlük yaşam aktivitelerini kısıtlamakta ve yaşam kalitesinde düşüşe yol 

açmaktadır. Karpal tünel sendromu cerrahisi en çok gerçekleştirilen el cerrahisi olarak 

bildirilmiştir (12). Her bir KTS cerrahisi için gerekli tedavi maliyeti ve cerrahi sonrası işe 

dönüş süresine bağlı iş gücü kaybı göz önüne alındığında hastalığın erken tanı ve tedavisi 

önem kazanmaktadır. 

Literatürde canalis carpi anatomisini inceleyen çok sayıda erişkin kadavra çalışması 

bulunmasına rağmen konu ile ilgili fetus çalışmasına rastlanılmamıştır. Canalis carpi 

anatomisini ve KTS etiyolojisini açıklayan çalışmalardan farklı olarak bu çalışmada fetus 

kadavraları üzerinde çalışılmıştır. 

 Bu çalışmanın amacı, fetus kadavralarında el ve el bileği ile ilgili antropometrik 

ölçümler ve canalis carpi ve içeriğini oluşturan yapılar ile ilgili hesaplamalar yaparak; elde 

edilen verilerin fetusların cinsiyetine, intrauterin yaşına, nöral tüp defektine (NTD) ve 

lateralizasyona göre karşılaştırılması ve farklılıkların araştırılmasıdır. Çalışmada ulaşılacak 

sonuçlar ile canalis carpi’nin anatomisinin ve doğuştan gelen anatomik özelliklerin KTS 

etiyolojisinde oynadığı rolün daha iyi anlaşılması açısından literatüre katkı sağlaması 

hedeflenmiştir. 
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2. GENEL BİLGİLER 

2.1. Ekstremitelerin Embriyolojik Gelişimi 

Gestasyonun dokuzuncu haftasının başından doğuma kadar geçen süre fetal dönem 

olarak bilinir. Fetal dönemdeki gelişim vücudun hızlı büyümesi ve doku, organ ve 

sistemlerin farklılaşması ile ilgilidir (13). 

Ekstremitelerin gelişimi somatik lateral mezodermdeki bir grup mezenşimal 

hücrenin aktivasyonu ile başlar (13). Gelişimin dördüncü haftasının sonunda, ekstremite 

tomurcukları ventrolateral vücut duvarında birer küçük kabartı olarak belirir (13, 14). 

Ekstremite gelişiminin erken aşamaları üst ve alt ekstremiteler için benzerdir ancak; 

daha sonra el ve ayaklarda şekil ve fonksiyon bakımından önemli farklılıklar oluşur. Üst 

ekstremite tomurcukları gelişimin 26. veya 27. günlerinde görünür hale gelirken, alt 

ekstremite tomurcukları bir veya iki gün sonra görünür (13, 15). Her iki ekstremite 

tomurcuğu da başlangıçta küboidal ektoderm tabakası ile örtülü bir mezenşimal kitleden 

oluşur. Lateral plak mezoderminin somatik tabakasından meydana gelen bu mezenşimal 

kitle, ekstremitelerin kemiklerini ve bağ dokusunu oluşturur (Şekil 1) (14).  

 

Şekil 1. İnsan embriyosunda ekstremite tomurcuklarının gelişimi. (A) Dördüncü hafta. (B) 

Beşinci hafta. (C) Altıncı hafta. (D) Sekizinci hafta (Sadler’den, 14) 

Ekstremitelerin distal sınırındaki ektoderm tabakası, apikal ektodermal kabartıyı 

(AEK) oluşturmak için kalınlaşır. Bu yapı, mezenşimden köken alan çok katmanlı 

özelleşmiş bir epitel yapıdır (13). Apikal ektodermal kabartı, bitişiğindeki mezenşim 

üzerinde indüktif bir etkiye sahiptir ve bu şekilde; komşu mezenşimin farklılaşmamış ve 

hızlı çoğalan hücreler olarak kalmasına neden olur. Buna karşılık; AEK’nin etkisinden 

uzaktaki hücreler ise kıkırdak ve kas dokusuna doğru farklılaşır. Böylece ekstremite 

gelişimi, proksimalden distale doğru ilerler (14). 
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Gelişimin altıncı haftasında; ekstremite tomurcuklarının distal kısmı, el plakalarını 

oluşturmak için proksimal kısımdan ayrılarak yassılaşır. Bu plakalar, proksimal 

segmentten bir boğum ile ayrılır (14, 16). Altıncı haftanın sonunda; el plakalarındaki 

mezenşimal doku yoğunlaşır ve parmak uzantılarını oluşturur. Her bir parmak uzantısının 

distalinde AEK, mezenşimi indükleyerek parmakların phalanx’larının gelişmesini sağlar. 

Parmak uzantılarının arası gevşek mezenşim tarafından doldurulur. Apikal ektodermal 

kabartıdaki hücre ölümü bu yapıyı beş parçaya ayırır ve parmak çıkıntıları arasında 

çentikler oluşturur. Sekizinci haftanın sonunda doku yıkımının ilerlemesi ile birbirinden 

ayrı parmaklar oluşur (Şekil 2). Bu doku yıkımı sürecinden programlanmış hücre ölümü 

(apoptozis) sorumludur. Parmaklar arasındaki apoptozisin gerçekleşmesini sağlayan 

hücresel ve moleküler olayların blokajı, parmakların sindaktilisi ile sonuçlanır (13, 14, 16).  

 

Şekil 2. 4-8 haftalık embriyoda elin gelişimi. (A) 27. gün. (B) 32. gün. (C) 41. gün. (D):46. 

gün. (E) 50. gün. (F) 52. gün (Moore’dan, 13) 

Ekstremiteler uzadıkça, ekstremite tomurcuklarındaki mezenşimal hücreler 

yoğunlaşır ve kondrositlere dönüşür (13, 14). Gelişimin altıncı haftasında; bu kondrositler, 

ekstremite kemiklerinin öncüsü olan hyalin kıkırdak modelini oluşturur (14). Altıncı 

haftanın sonunda tüm ekstremite iskeleti kıkırdak yapıdadır (13). Yedinci haftada; uzun 

kemikler, kıkırdak modelin ortasındaki primer ossifikasyon merkezinden kemikleşmeye 

başlar. Gelişimin 12. haftasından itibaren ekstremitelerin tüm uzun kemiklerinde primer 

ossifikasyon merkezleri mevcuttur (13). Radius ve ulna’nın kemikleşmesi yedinci ve 

sekizinci haftalarda başlar. El bileği kemiklerinde primer ossifikasyon merkezleri postnatal 

dönemde görülmeye başlar. Ossa metacarpi’ler embriyolojik gelişimin ikinci ve üçüncü 

aylarında kemikleşir. El parmak kemiklerinin kemikleşmesi ise yedinci hafta ile 12. 

haftalar arasındadır (16, 17). 
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Kondrogenezin kesintiye uğraması ile bir eklem ara bölgesi açığa çıkar. Başlangıçta 

bu bölgede hücre sayısı ve yoğunluğu artar. Bu bölgedeki hücreler, komşu mezenşimal 

hücrelerden farklı sitolojik özelliklere sahiptir. Daha sonra hücre ölümü gerçekleşir ve 

eklem boşluğu oluşur. Eklem boşluğunun oluşumu, gelişimin dokuzuncu ve 11. 

haftalarında gerçekleşir. Eklem boşluğunu çevreleyen mezenşimal hücreler, eklem 

kapsülünü geliştirir (14, 16, 17). 

Ekstremite kas yapısının oluşumunun ilk belirtileri gelişimin yedinci haftasında 

görülür. Uzun kemikler şekillenirken, ekstremite tomurcuklarının tabanında mezenşimal 

yoğunlaşma gerçekleşir. Myoblastlar toplanır ve ekstremite tomurcuğunda büyük bir kas 

kitlesi oluşur (13, 14). Bu kas kitlesi genellikle ventral (fleksor) ve dorsal (ekstansor) 

olmak üzere iki komponente ayrılır (13, 18). Ekstremite tomurcuklarındaki mezenşim, 

ligamentlerin ve kan damarlarının oluşumunu da sağlar (13). 

Üst ekstremite tomurcukları, alt beş servikal ve üst iki torakal segmentlerin 

karşısında gelişir (14, 18). Tomurcukların oluşmasını takiben uygun spinal sinirlerin 

ventral dalları, mezenşim dokusuna penetre olur. Başlangıçta her bir ventral dal, kendi 

segmentine ait ventral ve dorsal sinirleri oluşturmak için birleşir. Böylece; dorsal 

segmental dalların birleşmesi ile n. radialis oluşur ve ekstansor kas sistemini inerve eder. 

Fleksor kas sistemini inerve eden n. medianus ve n. ulnaris ise ventral segmental dalların 

birleşmesi ile oluşur (14). 

Gelişmekte olan üst ve alt ekstremiteler gelişimin yedinci haftasında zıt yönlerde ve 

farklı derecelerde rotasyona uğrar. Üst ekstremiteler, uzun eksenleri boyunca 90˚ laterale 

döner. Böylece gelecekteki dirsekler dorsale bakar. Başparmaklar lateralde yerleşir. 

Ekstansor kaslar ekstremitelerin lateral ve posterior yüzlerinde uzanır. Alt ekstremiteler ise 

90˚’ye yakın olacak şekilde mediale döner. Bu şekilde, gelecekteki dizler ventrali gösterir. 

Başparmaklar medialde yerleşir. Ekstansor kaslar ise ekstremitelerin anterior yüzünde 

uzanır (13, 14, 18). 

2.2. El Anatomisi 

El; önkolun distalinde konumlanan ve üst ekstremite fonksiyonları için anahtar rol 

oynayan bir organdır. 

İnce hareketler yapabilen ve duyu bilgisi sağlayan gelişmiş organizasyonu 

sayesinde insanlar alet yapabilme, kullanabilme ve geliştirebilme yeteneğine sahiptir (1). 
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İnsanı diğer canlılardan ayıran iki organ, beyin ve eldir. Elin hareketleri beynin birçok 

farklı bölümü tarafından kontrol edilir. Duyu ve motor korteks üzerinde diğer organlara 

göre en geniş alanı el kaplar. Elin karmaşık hareketlerini gerçekleştirebilmesi ve duyu 

organı gibi fonksiyon görebilmesi, bu iki organ arasındaki hassas koordinasyonun iyi 

olmasına bağlıdır (16, 19). 

El, ince motor cevap oluşturma ve bir uygulama organı olmasının yanında; aynı 

zamanda bilgi edinmek üzere tasarlanmış bir organdır. İnsanın çevre ile etkileşime 

girmesinde oldukça önemli bir role sahiptir. El, cisimlere dokunarak onları tanımlamamızı; 

cisimlerin yüzey yapısı, ağırlık, şekil, boyut ve termal özellikleri hakkında bilgi elde 

etmemizi sağlar. Nesnelere uzanma, kavrama, tutma ve bırakma aktiviteleri sırasında el 

becerisi gereklidir. Bunların yanı sıra el; sayı sayma, yazı, müzik, sanat, işaret dili, sosyal 

iletişim ve hijyen gibi konularda insana son derece iyi hizmet verir. (16, 20, 21). 

El bileği, elin proksimalinde yer alan ve eli önkola bağlayan bölümdür. Hareketli 

eklem sistemi sayesinde elin fonksiyonlarını en iyi şekilde yerine getirmesini sağlar (2, 

20). 

2.2.1. Elin İskeleti 

Elin iskeleti 27 adet kemikten oluşur. Ossa carpi, ossa metacarpi ve ossa digitorum 

(phalanges) elin iskeletini oluşturan kemiklerdir (Şekil 3) (1).  
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Şekil 3. El kemikleri (Putz’dan, 22) 

2.2.1.1. Ossa Carpi (El Bileği Kemikleri) 

El bileğinin iskeletini oluşturan bu kemikler, dört tanesi proksimal ve dört tanesi 

distalde olmak üzere iki sıra halinde dizilmişlerdir. Proksimal sıra kemikleri anatomik 

pozisyonda lateralden mediale doğru; os scaphoideum, os lunatum, os triquetrum ve os 

pisiforme’dir. Distal sıra kemikleri ise yine lateralden mediale doğru os trapezium, os 

trapezoideum, os capitatum ve os hamatum’dur (Şekil 4) (1, 20, 23). 

Os scaphoideum, proksimal sıra kemiklerin en büyüğüdür ve el biyomekaniğinde 

önemli role sahiptir. Palmar yüzünde tuberculum ossis scaphoidei denilen bir çıkıntısı 

vardır. Proksimal sıranın ortasında os lunatum bulunur. El bileği kemikleri arasında en sık 

kırılan kemik os scaphoideum iken en çok dislokasyona uğrayan kemik os lunatum’dur. Os 

pisiforme, el bileği kemiklerinin en küçüğüdür ve kemikleşme sürecini en son tamamlayan 

karpal kemiktir. Distal sıranın en küçük kemiği os trapezoideum’dur. El bileği 

kemiklerinin en büyüğü olan os capitatum el bileğinin merkezinde bulunur ve bir kilit taşı 
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rolü oynar. Os capitatum ilk önce kemikleşmeye başlayan karpal kemiktir. Os hamatum, 

palmar yüzünün medialinde yer alan ve hamulus ossis hamati denilen çengel şeklindeki 

çıkıntısı ile kolaylıkla tanınır (2, 24-26).  

 

Şekil 4. Ossa carpi önden görünüşü (Netter’den, 27) 

2.2.1.2. Ossa Metacarpi (El Tarağı Kemikleri) 

El tarağı kemikleri beş adet uzun ve ince kemikten oluşur. Lateralden mediale 

doğru I, II, III, IV ve V olarak isimlendirilirler. Proksimaldeki uçlarına basis metacarpalis, 

distaldeki uçlarına ise caput metacarpalis denir. Basis ve caput arasındaki bölüm ise corpus 

metacarpale olarak adlandırılır. Her bir basis metacarpalis distal sıradaki ossa carpi ile 

eklemleşirken; carput metacarpalis’ler parmakların pahalanges proximalis’leri ile eklem 

yapar (1, 20, 23).  

Os metacarpale I, metakarpal kemiklerin en kısa ve kalın olanıdır. Proksimal ucu os 

trapezium ile eklem yaptığı için eyer şeklindedir. En uzun metakarpal kemik os 

metacarpale II’dir. Os trapezium ve os trapezoideum ile eklemleştiğinden dolayı proksimal 

ucu kalın ve geniştir. Os metacarpale V’in en belirgin özelliği, proksimal ucunun medial 

kısmında eklem yüzünün bulunmamasıdır (24, 25). 
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2.2.1.3. Ossa Digitorum (Phalanges) (El Parmak Kemikleri) 

Bu kemikler el parmaklarının iskeletini oluşturur. Başparmakta phalanx proximalis 

ve phalanx distalis olmak üzere iki tanedir. Diğer parmaklarda ise phalanx proximalis, 

phalanx media ve phalanx distalis olmak üzere üçer tane phalanx bulunur. Her bir 

phalanx’ın basis phalangis, corpus phalangis ve caput phalangis olmak üzere üç kısmı 

vardır (1, 20, 23, 25). 

2.2.2. El Bileği ve El İskeletinin Eklemleri 

El bileği eklemi, radius ve discus articularis (ulna) ile proksimal sırada bulunan 

karpal kemikler arasındaki sinoviyal eklem olan art. radiocarpalis’tir (23). El bileği 

kemikleri (ossa carpi), el tarağı kemikleri (ossa metacarpi) ve el parmak kemikleri (ossa 

digitorum) arasındaki eklemlerin tümü birden ise articulationes manus’u oluşturur (Şekil 5) 

(24).  

 

Şekil 5. El ve el bileğinin eklemleri (Schünke’den, 28) 
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2.2.2.1. Articulatio Radiocarpalis 

Articulatio radiocarpalis, eli önkola bağlayan eklemdir. Konkav eklem yüzünü 

radius’un distal ucundaki facies articularis carpalis ile ulna’nın distal ucunu kaplayan 

discus articularis; konveks eklem yüzünü ise os scaphoideum, os lunatum ve os triquetrum 

oluşturur (1, 23, 24). Bu eklem art. ellipsoidea tipinde sinoviyal bir eklemdir. Transvers ve 

sagittal eksenlerde harekete izin verir. Articulatio metacapalis ile birlikte fleksiyon, 

ekstansiyon, abduksiyon, adduksiyon ve sirkumdiksiyon hareketlerini sağlar (1, 20). 

2.2.2.2. Articulationes Manus 

Articulationes İntercarpales  

Ossa carpi arasında oluşan eklemlerdir. Eklemin tipi art. plana tipinde olup sınırlı 

miktarda kayma hareketine sahiptirler (1, 24). 

Articulatio Mediocarpalis 

Proksimal ve distal sıradaki ossa carpi arasında oluşan eklemdir. Eklemin medial 

kısmı art. ellipsoidea, lateral kısmı art. plana tipi olarak kabul edilir. Sınırlı miktarda 

kayma hareketine izin verir (1, 24). 

Articulatio Carpometacarpalis Pollicis 

 Os metacarpale I’in proksimali ve os trapezium arasında oluşur. Bu eklem art. 

sellaris grubu bir eklemdir. Bu nedenle transvers ve sagittal olmak üzere iki ana eksene 

sahiptir. Başparmağa fleksiyon, ekstansiyon, abduksiyon, adduksiyon, opozisyon ve 

sirkumdiksiyon yaptırarak geniş bir hareket olanağı sağlar (1, 20, 24, 29). 

Articulationes Carpometacarpales II, III, IV, V  

Ossa metacarpi II, III, IV, V’in proksimal uçları ile distal sıradaki ossa carpi 

arasında bulunan eklemlerdir. Eklem tipleri art. plana olup sınırlı kayma hareketine 

sahiptirler (1, 20, 24). Articulatio carpometacarpalis II ve III’ün stabilite özelliği daha fazla 

iken art. carpometacarpalis IV ve V daha fazla hareketliliğe sahiptir (25, 29). 

Articulationes İntermetacarpales 

Ossa metacarpi II, III, IV, V’in proksimal uçlarının yan yüzeylerinin birbirleriyle 

yaptıkları eklemlerdir. Bu eklemler art. plana grubu eklemlerdir ve bu nedenle sınırlı 

kayma hareketi yaparlar (1, 24). 
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Articulationes Metacarpophalangeales 

Eklem yüzlerini ossa metacarpi I-V’in distal uçları ve I-V. phalanx proximalis’lerin 

proksimal uçları oluşturur. Eklem yüzünün şekline göre art. spheroidea, hareketlerine göre 

art. ellipsoidea grubu olarak kabul edilirler ancak; art. metacarpophalangealis I, eklem 

yüzünün şekli bakımından daha çok art. ginglymus grubu ekleme benzer. Bu eklemler ligg. 

collateralia, ligg. palmaria ve lig. metacarpale transversum profundum ile 

kuvvetlendirilmişlerdir. Geniş bir eklem kapsülüne sahip olup fleksiyon, ekstansiyon, 

abduksiyon, adduksiyon ve sirkumdiksiyon hareketlerini yapabilirler (1, 20, 23, 24, 29). 

Articulationes İnterphalangeales 

Phalanx’lar arasındaki art. ginglymus grubu eklemlerdir. Bu eklemlerde fleksiyon 

ve ekstansiyon hareketlerine izin verilir. Ligamentum collaterale mediale, lig. collaterale 

laterale ve lig. palmare tarafından desteklenirler (1, 20, 23, 29). 

2.2.3. Elin Fascia’ları 

2.2.3.1. Fascia Superficialis  

 Elin dorsal yüzündeki fascia superficialis ince yapılı, esnek ve hareketlidir. 

Yüzeyel ve derin olmak üzere iki yaprağı vardır ve bu iki yaprağı birbirinden ayırmak 

kolaydır. Yüzeyel yaprak bir miktar yağ dokusu içerir. Fibröz bir tabaka şeklinde olan 

derin yaprak, yüzeyel venler ile deri sinirlerini bulundurur (Şekil 6). 

 Elin palmar yüzündeki fascia superficialis dorsal yüze göre daha kalındır ve 

esnekliği daha azdır. Bol miktarda yağ dokusu içerir. Buradaki yağ dokusu, sağlam fibröz 

bantlar ve bölmelerle küçük lobcuklara ayrılmıştır. Avuç derisi çok yoğun bir yapıya 

sahiptir ve böylece deri altındaki yapılar basınç ve enfeksiyonlara karşı dayanıklı hale 

gelir. Fascia superficialis ve derinindeki fascia profunda birbirlerine sıkıca yapışmış 

haldedir. Özellikle el bileği, avuç ve parmaklarda deri oluklarının bulunduğu yerlerde daha 

kuvvetlidir ve deriye daha sıkı bir şekilde yapışmıştır (24, 29). 
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Şekil 6. Fascia superficialis’in elin palmar ve dorsal yüzünde görünüşü (Netter’den, 27) 

2.2.3.2. Fascia Profunda 

Önkoldaki fascia antebrachii’nin devamı olan fascia profunda, elin dorsal yüzünde 

çok ince yapılıdır. El bileği seviyesine geldiğinde kalınlaşarak retinaculum extensorum 

denilen bir bant oluşturur.  

Dorsal yüzdeki derin fascia, medialde os metacarpale V ve lateralde os metacarpale 

II’ye tutunarak elin palmar yüzündeki fascia profunda ile devam eder. Palmar yüzdeki 

fascia profunda’nın thenar kasları örten kısmına fascia thenaris, hypothenar kasları örten 

kısmına fascia hypothenaris denir. Fascia profunda el bileğinin ön yüzünde transvers 

liflerle kaynaşıp kalınlaşarak retinaculum flexorum’u, avucun santral kısmında 

kalınlaşarak aponeurosis palmaris’i, parmakların üzerinde kalınlaşarak da fibröz kılıfları 

meydana getirir (1, 24). 

Retinaculum Flexorum 

Önkolun derin fascia’sı olan fascia antebrachii, el bileği seviyesinde transvers 

olarak uzanmış liflerle birlikte güçlü bir fibröz bant olan retinaculum flexorum’u oluşturur. 

Retinaculum flexorum, yüzeyelde lig. carpi palmare ve derinde lig. carpi transversum 

olmak üzere iki kısma ayrılır.  

Ligamentum carpi palmare, processus styloideus radii ve processus styloideus ulnae 

arasında uzanan kısımdır. Retinaculum flexorum’un esasını oluşturan lig. carpi 

transversum, lig. carpi palmare’nin derininde yer alır. Bu bağ, medialde os pisiforme ile 

hamulus ossis hamati’ye tutunur. Lateralde ise yüzeyel ve derin olmak üzere iki yaprak 

olarak uzanır. Yüzeyel yaprağı tuberculum ossis scaphoidei ile os trapezium’un oluğuna 

tutunurken derin yaprağı bu oluğun medial kenarına tutunur (Şekil 7). Ligamentum carpi 

transversum’un uzunluğu ortalama 28.5±0.8 mm’dir (2, 24, 30-32). 
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Şekil 7. Retinaculum flexorum (Schünke’den, 28) 

Retinaculum flexorum ile ossa carpi arasında oluşan açıklığa canalis carpi denir ve 

n. medianus ile fleksor kasların tendonları buradan geçerek ele ulaşır (1, 2). 

Aponeurosis Palmaris 

Retinaculum flexorum distalde aponeurosis palmaris ile devam eder. Aponeurosis 

palmaris, fascia profunda’nın avuç içini örten kısmıdır. Kalın, kuvvetli ve üçgen şeklinde 

bir yapıdır (Şekil 8). Üçgenin tepesi retinaculum flexorum’a yapışır ve m. palmaris 

longus’un tendonu ile devam eder. Tabanı, her bir parmağa gidecek şekilde dört adet banda 

ayrılır. Her bir parmağa giden bantlar tekrar iki tabakaya ayrılır. Parmaklara longitudinal 

olarak uzanan yüzeyel lifleri birbirine bağlayan transvers lifler art. 

metacarpophalangealis’in palmar yüzünde lig. metacarpale transversum superficialis’i 

yapar (1, 20, 24, 30). 
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Şekil 8. Aponeurosis palmaris (Putz’dan, 22) 

Aponeurosis palmaris’in kenarlarından arkaya doğru uzanan septum thenaris ve 

septum hypothenaris; eli thenar, hypothenar ve santral olmak üzere üç kompartmana ayırır 

(1, 24). 

2.2.4. Elin Kasları 

2.2.4.1. Thenar Kaslar (Musculi Thenares) 

Thenar kasları m. abductor pollicis brevis, m. flexor pollicis brevis, m. opponens 

pollicis ve m. adductor pollicis oluşturur. Thenar kaslar elin palmar yüzünde eminentia 

thenaris denilen kabarıklığı oluşturur (Şekil 9) (1, 20, 23, 33). 

Musculus Abductor Pollicis Brevis 

Thenar bölgenin en yüzeyel kası olup ince ve yassıdır. Retinaculum flexorum, 

tuberculum ossis scaphoidei ve os trapezium’dan başlar. Aşağı ve laterale doğru uzanıp 

başparmağın phalanx proximalis’inin basis’inde sonlanır. Başparmağa 

metacarpophalangeal eklemde abduksiyon yaptırır ve n. medianus tarafından inerve edilir 

(1, 20, 23, 24). 

Musculus Flexor Pollicis Brevis  

Bu kas m. abductor pollicis brevis’in medialinde ve distalinde bulunur. Lateralde 

caput superficiale ve medialde caput profundum olmak üzere iki başı vardır. Caput 
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superficiale, retinaculum flexorum’un distal kenarı ile tuberculum ossis trapezium’dan 

başlar. Caput profundum os trapezoideum ve os capitatum’dan başlar. Her iki başı da 

başparmağın phalanx proximalis’inde sonlanır. Başparmağa fleksiyon yaptırır. Caput 

superficiale n. medianus, caput profundum ise n. ulnaris tarafından inerve edilir (1, 20, 23, 

24). 

Musculus Opponens Pollicis 

Bu kas m. abductor pollicis brevis’in derininde yer alan üçgen şeklinde bir kastır. 

Retinaculum flexorom’un laterali ile tuberculum ossis trapezium’dan başlayıp os 

metacarpale I’in lateral kenarında sonlanır. Başparmağa fleksiyon, adduksiyon ve iç 

rotasyon hareketlerinden oluşan opozisyon hareketini yaptırır; n. medianus tarafından 

inerve edilir (1, 23, 24). 

Musculus Adductor Pollicis 

Caput obliquum ve caput transversum olmak üzere iki başı vardır. Caput obliquum 

os capitatum, os metacarpale II ve III ile m. flexor carpi radialis’in tendonundan başlar. 

Caput transversum ise os metacarpale III’ün palmar yüzünün distal 2/3’lük kısmından 

başlar. Her iki başı da başparmağın phalanx proximalis’inin basis’inde sonlanır. 

Başparmağa adduksiyon yaptırır ve opozisyona yardım eder; n. ulnaris tarafından inerve 

edilir (1, 23, 24, 33). 

2.2.4.2. Hypothenar Kaslar (Musculi Hypothenares) 

Hypothenar kasları m. palmaris brevis, m. abductor digiti minimi brevis, m. flexor 

digiti minimi ve m. opponens digiti minimi oluşturur. Bu kasların elin palmar yüzünde 

oluşturdukları kabartıya eminentia hypothenaris denir (Şekil 9) (1, 20, 33). 

Musculus Palmaris Brevis 

Bu kas fascia superficialis’in içerisinde bulunan çok ince bir kastır. Aponeurosis 

palmaris’in medial kenarından başlayarak elin ulnar tarafındaki deride sonlanır. Elin ulnar 

kısmındaki deriyi gerer ve eminentia hypothenaris’i belirgin hale getirir; n. ulnaris 

tarafından inerve edilir (1, 24). 
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Musculus Abductor Digiti Minimi 

Os pisiforme ve m. flexor carpi ulnaris’in tendonundan başlayıp V. parmağın 

phalanx proximalis’inde sonlanır. Beşinci parmağın abduksiyonundan sorumludur ve n. 

ulnaris tarafından inerve edilir (1, 20, 23, 24). 

Musculus Flexor Digiti Minimi Brevis 

 Os hamatum ve retinaculum flexorum’dan başlayıp V. parmağın phalanx 

proximalis’inin basis’inde sonlanır. Beşinci parmağın phalanx proximalis’ine fleksiyon 

yaptırır ve n. ulnaris tarafından inerve edilir (1, 23). 

Musculus Opponens Digiti Minimi 

Os hamatum ve retinaculum flexorum’dan başlar. Os metacarpale V’te sonanır. 

Beşinci parmağa opozisyon yaptırır ve n. ulnaris tarafından inerve edilir (1, 24).  

 

Şekil 9. Thenar ve hypothenar kaslar (Schünke’den, 28) 

2.2.4.3. Elin Derin Kasları  

Elin orta kısmında bulunan bu kasları mm. lumbricales, mm. interossei dorsales ve 

mm. interossei palmares oluşturur.  
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Musculi Lumbricales 

Her biri bir parmakla ilgili olan dört adet ince, uzun ve solucan benzeri kaslardır. 

Bu kaslar m. flexor digitorum profundus’un tendonlarından başlar; II-V. parmakların 

aponeurosis dorsalis’lerinin lateral kenarlarında sonlanırlar. Parmakların phalanx 

proximalis’lerine fleksiyon, phalanx media ve phalanx distalis’lerine ekstansiyon 

yaptırırlar. İlk iki m. lumbricalis, n. medianus tarafından; III. ve IV. m. lumbricalis, n. 

ulnaris tarafından inerve edilir (Şekil 10 ) (1, 20, 23, 24, 33). 

 

Şekil 10. Mm. lumbricales (Putz’dan, 22) 

Musculi İnterossei Dorsales 

Dört tanedir. Arasında uzandığı ossa metacarpi’lerden başlarlar. İkinci ve III. 

parmakların aponeurosis dorsalis’lerinin radial tarafında, III. ve IV. parmakların 

aponeurosis dorsalis’lerinin ulnar tarafında sonlanırlar. Parmaklara abduksiyon hareketi 

yaptırırlar; n. ulnaris tarafından inerve edilirler (Şekil 11 ) (1, 23, 24). 

Musculi İnterossei Palmares 

Üç tanedir. Os metacarpale II, IV ve V’in palmar yüzlerinden başlarlar. İkinci 

parmağın aponeurosis dorsalis’inin ulnar tarafı, IV. ve V. parmakların aponeurosis 

dorsalis’lerinin radial tarafında sonlanırlar. Parmaklara adduksiyon yaptırırlar ve n. ulnaris 

tarafından inerve edilirler (Şekil 11) (1, 23, 24). 
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Şekil 11. Mm. interossei dorsales ve mm. interossei palmares (Putz’dan, 22) 

2.2.5. Elin Arterleri 

Üst ekstremiteyi besleyen a. subclavia, birinci costa’nın dış kenarına geldiğinde a. 

axillaris adını alır. Arteria axillaris, m. teres major’un alt kenarı seviyesinden itibaren a. 

brachialis olarak devam eder. Arteria brachialis ise fossa cubitalis seviyesinde a. ulnaris ve 

a. radialis olmak üzere iki uç dalını verir. Arteria ulnaris ve a. radialis avuç içinde yüzeyel 

ve derin olmak üzere iki arter ağı oluşturarak elin beslenmesini sağlar (1, 20, 29). 

2.2.5.1. Arcus Palmaris Superficialis 

Arteria ulnaris ile a. radialis’in dalı olan r. palmaris superficialis arasındaki 

anastomozdur. Buradan üç adet aa. digitales palmares communes çıkar ve arcus palmaris 

profundus’tan gelen aa. metacarpales palmares ile birleşir. Buradan da her parmakta ikişer 

tane olan aa. digitales palmares propriae çıkar. Bunlar medial ve lateral kenarlar boyunca 

ilerleyip parmakların distal kısımlarında birbirleri ile anastomoz yaparlar (Şekil 12) (1, 20). 

2.2.5.2. Arcus Palmaris Profundus  

Arteria radialis’in uç kısmı, a. ulnaris’in r. palmaris superficialis dalı ile anastomoz 

yaparak bu arter ağını oluşturur. Buradan çıkan üç tane aa. metacarpales palmares, arcus 

palmaris superficialis’ten gelen aa. digitales palmares communes ile birleşir. Arcus 

palmaris profundus’tan çıkan rr. perforantes aa. metacarpales dorsales ile anastomoz yapar 

(Şekil 12) (1, 20). 
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Şekil 12. Arcus palmaris superficialis ve arcus palmaris profundus (Putz’dan, 22) 

2.2.6. Elin Venleri 

Elin venleri yüzeyel ve derin venler olarak iki grupta incelenir. Yüzeyel ve derin 

venöz ağlar arasında bağlantılar vardır. 

2.2.6.1. Yüzeyel Venler  

Venae digitales dorsales’ler parmakların dorsal yüzünde birleşerek üç tane vv. 

metacarpales dorsales’leri meydana getirir. Bunlar birbirleri ile anastomoz yaparak rete 

venosum dorsale manus denilen venöz ağı oluşturur. Venae digitales palmares palmar 

yüzde arcus venosus palmaris superficialis’i meydana getirir. Bu arcus rete venosum 

dorsale manus’a vv. intercapitulares aracılığı ile açılır. Rete venosum dorsale manus’un bir 

kısmı v. mediana basilica aracılığı ile v. mediana antebrachii olarak yukarıda v. basilica’ya 

katılır. Bir kısmı ise v. mediana cubiti’ye katılır (1, 20). 

Vena cephalica önkolun radial tarafında rete venosum dorsale manus’tan başlar ve 

clavicula’nın alt seviyesinde v. axillaris’e açılır. Vena basilica ise önkolun ulnar tarafında 

rete venosum dorsale manus’tan başlar ve v. axillaris’e açılır. Vena cephalica ile v. basilica 

dirsek ekleminin önünde v. mediana cubiti tarafından birleştirilir. Vena mediana cephalica, 

v. mediana antebrachii ve v. cephalica arasındaki vendir (1).  
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2.2.6.2. Derin Venler  

Derin venler genellikle çift olup aynı isimli arterleri izlerler. Elde vv. metacarpales 

palmares’in meydana getirdiği arcus venosus palmaris profundus’tan başlarlar. Bu arcus 

yukarıya doğru vv. ulnares ve vv. radiales olarak devam eder. Venae ulnares ve vv. 

radiales dirsek eklemi önünde birleşerek vv. brachiales’i oluşturur. Venae brachiales ise v. 

axillaris’e katılır (1). 

2.2.7. Elin İnervasyonu 

Elin duyusal ve motor inervasyonu n. medianus, n. ulnaris ve n. radialis tarafından 

sağlanır (20, 29).  

2.2.7.1. Duyusal İnervasyon 

Elin dorsal yüzünde n. medianus’un dalları olan nn digitales palmares; I., II. ve III. 

parmakların phalanx distalis’leri ile IV. parmağın radial yarısının derisinin inervasyonunu 

sağlar. Nervus ulnaris’in r. dorsalis dalı; elin dorsal yüzünün derisinin ulnar yarısını, V. 

parmağın dorsal yüzünün tamamını ve dorsal yüzde IV. parmağın ulnar yarısını inerve 

eder. Nervus radialis’in r. dorsalis superficialis dalı elin dorsal yüzünün radial kısmının 

derisini inerve eder. Ramus dorsalis superficialis parmakların dorsal yüzüne nn. digitales 

dorsales dallarını vererek I. ve II. parmaklar ile III. parmağın radial yarısının phalanx 

proximalis’lerinin dorsal derisini inerve eder (Şekil 13) (1, 20, 29, 34). 

Palmar yüzde thenar bölgenin deri duyusunu n. medianus’un r. palmaris dalı sağlar. 

Aynı sinirin nn digitales communes dalları; I., II., III. parmaklar ile IV. parmağın radial 

yarısının derisini inerve eder. Nervus ulnaris’in r. palmaris dalı avuç içinin ulnar kısmını; r. 

superficialis dalı ise V. parmak ile IV. parmağın ulnar yarısını inerve eder. Nervus 

radialis’in r. superficialis dalı thenar bölgenin üzerindeki küçük bir deri sahasını inerve 

eder (Şekil 13) (1, 20, 29). 
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Şekil 13. Elin palmar ve dorsal yüzünün duyusal inervasyonu (Netter’den, 27) 

2.2.7.2. Motor İnervasyon 

  Elin intrinsik kasları n. medianus ve n. ulnaris tarafından inerve edilir. Nervus 

ulnaris’in motor lifler içeren dalı olan r. profundus hypothenar kasları inerve eder. Ayrıca 

III. ve IV. m. lumbricalis’ler ile mm. interossei’ye motor lifler verir. Daha sonra m. 

adductor pollicis ve m. flexor pollicis brevis’in caput profundum’unu inerve ederek 

sonlanır. Nervus medianus’un r. recurrens dalı elde thenar bölge kaslarını inerve eder. İlk 

iki mm. lumbricales’in motor inervasyonu n. medinus’un r. palmaris profundus dalı 

tarafından sağlanır (1, 20, 23, 29, 34). 

2.2.8. Canalis Carpi’nin Anatomisi  

2.2.8.1. Canalis Carpi’nin Sınırları  

Canalis carpi, el bileğinde retinaculum flexorum ile ossa carpi arasında kalan sert 

osteofibröz bir kanaldır (Şekil 14). Palmar tarafta lig carpi transversum, medialde os 

pisiforme ve hamulus ossis hamati, lateralde os scaphoideum ve os trapezium, dorsalde 

ossa carpi tarafından sınırlandırılır. Ligamentum carpi transversum medial ve lateral 

duvarlar arasında bir köprü gibi uzanarak canalis carpi’nin tavanını oluşturur. Kanalın 

tabanı ise eklem kapsülünden meydana gelir (2, 5, 30, 35). 

Canalis carpi önkolun distalini elin derin palmar boşluğu ile birleştirir. Canalis 

carpi’nin transvers kesitlerde medialden laterale doğru olan genişliği proksimalde yaklaşık 

25 mm, hamulus ossis hamati seviyesinde yaklaşık 20 mm ve distalde yaklaşık 26 mm’dir. 

Kanalın palmar taraftan dorsal tarafa doğru olan yüksekliği proksimal ve distalde sırasıyla 
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12 ve 13 mm iken; hamulus ossis hamati seviyesinde yaklaşık olarak 10 mm’dir. Canalis 

carpi’nin en dar yeri hamulus ossis hamati seviyesidir. Bu seviye kanalın girişinden 

yaklaşık 2-2.5 cm distalde bulunur (31, 36-38). Canalis carpi’nin enine kesiti, uzun ekseni 

kısa eksenin iki katı olan bir elips şekline sahiptir. Kanalın enine kesit alanı ortalama 185 

mm²dir ve el bileğinin toplam kesit alanının yalnızca %20’sini oluşturur (36-39).  

 

Şekil 14. Canalis carpi ve içeriği (Netter’den, 27) 

2.2.8.2. Canalis Carpi’nin İçeriği 

Canalis carpi’nin içerisinden n. medianus, m. flexor digitorum profundus’a ait dört 

tendon, m. flexor digitorum superficialis’e ait dört tendon ve m. flexor pollicis longus’un 

tendonu geçerek ele ulaşır (Şekil 14) (1, 5, 38, 40).  

Canalis carpi’nin içerisinde en yüzeyelde bulunan yapı n. medianus’tur. Kanalın 

girişinde n. medianus retinaculum flexorum ile m. palmaris longus’un tendonunun hemen 

derininde yerleşmiştir. Canalis carpi’ye girmeden önce r. palmaris superficialis dalını verir. 

Kanalın distal kısmında ise üç adet terminal dalına ayrılır (2, 5, 30, 38). 

 Parmaklara doğru uzanan sekiz adet fleksor tendon ortak bir sinoviyal kılıf ile 

sarılıdır. Üçüncü ve IV. parmakların m. fleksor digitorum superficialis tendonları, II. ve V. 

parmaklara ait m. fleksor digitorum superficialis tendonlarına göre daha yüzeyelde 

bulunur. Musculus fleksor digitorum profundus’un tendonları ise m. fleksor digitorum 

superficialis’in tendonlarının daha derininde konumlanmıştır. Canalis carpi’nin en radial 

tarafındaki yapı m. fleksor pollicis longus’un tendonudur (2, 5, 41).  
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Nervus Medianus 

Fasciculus lateralis’ten çıkan radix lateralis (C5, C6, C7) ile fasciculus medialis’ten 

çıkan radix medialis (C8, T1), a. axillaris’in önünde birleşerek n. medianus’u oluşturur (1, 

42). 

Nervus medianus kolda sulcus bicipitalis medialis’te a. brachialis ve a. ulnaris ile 

beraber aşağı doğru seyreder. Başlangıçta a. axillaris’in ön tarafında yer alan n. medianus 

aşağıda arterin lateralinde bulunur. Kolun ortalarına geldiğinde a. axillaris’i önden 

çaprazlayıp mediale geçer. Daha sonra fossa cubitalis’in ön tarafına gelen n. medianus 

burada m. brachialis’in yüzeyelinde ve m. biceps brachii’nin medialinde bulunur. 

Musculus pronator teres’in iki başı arasından geçerek önkola ulaşır. Burada n. interosseus 

anterior dalını verir. Önkolda m. flexor digitorum superficialis ve m. flexor digitorum 

profundus arasında el bileğine kadar seyreder. Önkolun alt kısmında m. palmaris longus ve 

m. flexor carpi radialis kasları arasında yüzeyel olarak bulunur (1, 42, 43). Canalis carpi’ye 

girmeden hemen önce m. palmaris longus’un radial tarafındadır (44). Nervus medianus 

fleksor kaslara ait tendonlar ile birlikte retinaculum flexorum’un derinde canalis carpi’den 

geçerek elin palmar yüzüne ulaşır. Burada yalnızca deri ve aponeurosis palmaris ile 

örtülüdür ve derininde fleksor kasların tendonları yer alır (42).  

Canalis carpi’nin girişinde oval şeklinde olan n. medianus kanal boyunca distale 

doğru ilerlerken giderek yassılaşır (3, 38, 41). Sinirin enine kesit alanı kanalın girişinde 

8.55±1.56 mm² iken; kanalın çıkışında 7.72±1.41 mm² olarak ölçülmüştür (45). 

Nervus Medianus’un Dalları 

Nervus medianus kolda genellikle dal vermez. Ancak bazı durumlarda kolun distal 

kısmında m. pronator teres’e giden bir dal ve dirsek eklemine birkaç duyusal dal verebilir 

(Şekil 15) (42).  

Rami Musculares (önkoldaki): Önkolun ön bölgesindeki yüzeyel kaslardan m. flexor 

carpi ulnaris dışındaki diğer kasları inerve eder (42, 43). 

Nervus İnterosseus Anterior: Membrana interossea’nın önünde ve m. flexor pollicis 

longus ile m. flexor digitorum profundus’un arasında seyrederek el bileğine kadar uzanır. 

Burada m. pronator quadratus ve el bileği eklemine dağılan uç dallar verir. Önkolun ön 

bölgesindeki derin kaslardan m. flexor digitorum profundus’un ulnar yarısı dışındaki 

kasları inerve eder (1, 42, 43). 
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Ramus Palmaris Nervi Mediani: El bileğinin hemen proksimalinde fascia antebrachii’yi 

delerek yüzeyelleşir. Daha sonra retinaculum flexorum’un yüzeyelinden geçerek medial ve 

lateral dallarına ayrılır. Bu dallar thenar bölgenin derisinde dağılır (42, 43). 

Rami Musculares: Nervus medianus’un radial tarafından ayrılan kısa bir daldır. 

Retinaculum flexorum’un derininden geçerek thenar kaslara gider. Burada m. adductor 

pollicis ve m. flexor pollicis brevis’in caput profundum’u dışındaki tüm thenar kasları 

inerve eder (42-44). 

Nervi Digitales Palmares Communes: Nervus medianus retinaculum flexorum’un 

derininde canalis carpi’den geçtikten hemen sonra n. digitalis palmaris communis olarak 

adlandırılan üç dala ayrılır. Bu dallar genellikle duyusal liflerden oluşur. Radial tarafta 

bulunan birinci dal üç dala ayrılır. İlk ikisi baş parmağın her iki yanına dağılır. Üçüncüsü 

II. parmağın radial tarafına dağılırken ayrıca m. lumbricalis I’e somatomotor dal verir. 

İkinci dalı m. lumbricalis II’ye somatomotor dal verir. Daha sonra II. ve III. parmakların 

kökleri arasında iki adet n. digitalis palmaris proprius’a ayrılır. Üçüncü dalı nadiren m. 

lumbricalis III’e somatomotor dal verebilir, III. ve IV. parmakların kökünde iki dalına (n. 

digitalis palmaris proprius) ayrılır (42-44, 46). 

Nervi Digitales Palmares Propriae: Nervi digitales palmares communes’in parmaklarda 

dağılan uç dallarıdır. Bu dallar dağıldığı ilk üç buçuk parmağın palmar yüzlerini ve 

parmakların dorsalinde son iki phalanx üzerindeki deriyi inerve eder (42, 43).  
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Şekil 15. N. medianus’un üst ekstremitedeki seyri ve dalları (Putz’dan, 28) 

Musculus Flexor Digitorum Superficialis  

Önkolun ön bölgesindeki yüzeyel kaslar arasında en derinde bulunan ve en geniş 

olan kastır. Caput humeroulnare ve caput radiale olmak üzere iki başı vardır. Caput 

humeroulnare ortak bir tendon ile epicondylus medialis, lig collaterale ulnare ve ulna’nın 

processus coronoideus’undan başlar. Caput radiale ise radius’un ön yüzünün üst yarısından 

başlar. Bu kas önkolun distalinde her bir parmağa (II-IV) giden dört adet tendona ayrılır. 

Bu tendonlardan III. ve IV. parmaklara gidenler, II. ve IV. parmaklara gidenlere göre daha 

yüzeyelde bulunur. Kasın tendonları, retinaculum flexorum’un derininde canalis carpi’den 

geçerek ait oldukları parmaklara doğru uzanırlar. Daha sonra her bir tendon parmakların 

phalanx proximalis’leri hizasında tekrar ikiye ayrılır. Bu iki tendon arasında kalan açıklığa 

hiatus tendineus denir ve bu açıklıktan m. flexor digitorum profundus’un tendonları geçer. 
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Her bir tendon II-V. parmakların phalanx media’larının her iki yanına tutunarak sonlanır 

(Şekil 16) (1, 23, 24, 29, 47). 

Musculus flexor digitorum profundus öncelikle parmakların phalanx media’larına 

sonra phalanx proximalis’lerine ve dolayısı ile ele fleksiyon yaptırır; n. medianus 

tarafından inerve edilir (1, 23, 24, 47). 

Musculus Flexor Digitorum Profundus 

Önkolun ön bölgesindeki yüzeyel kasların derininde ve ulnar tarafta yer alır. 

Ulna’nın ön ve medial yüzünün üst 2/3 kısmından, processus coronoideus’un medial yüzü 

ve membrana interossea’dan başlar. Önkolun distal 1/3’ünde her bir parmağa gitmek üzere 

dört adet tendona ayrılır. Musculus flexor digitorum superficialis’in derininde bulunarak 

canalis carpi’den geçer ve ele ulaşır. Her bir tendonu phalanx proximalis hizasında hiatus 

tendineus’tan geçer ve phalanx distalis’in basis’ine yapışarak sonlanır. Kasın radial 

taraftaki lifleri ayrı bir grup halinde II. parmağa gider; III-V. parmaklara giden tendonlar el 

bileğine kadar birbirleri ile kısmen kaynaşmıştır (Şekil 16) (1, 23, 24, 47). 

Musculus flexor digitorum profundus öncelikle parmakların phalanx distalis’lerine 

sonra sırasıyla phalanx media ve phalanx proximalis’lerine fleksiyon yaptırır. Ayrıca elin 

fleksiyonuna yardım eder. Kasın medial kısmını n. ulnaris, lateral kısmını ise n. medianus 

(n. interosseus anterior) inerve eder (1, 23, 47). 

Musculus Flexor Pollicis Longus 

Musculus flexor digitorum profundus’un radial tarafında yer alır. Radius’un ön 

yüzünün üst 3/4 kısmından ve membrana interossea’dan başlar. Retinaculum flexorum’un 

derininde canalis carpi’den geçerek ele ulaşır. Thenar kasların arasından geçerek ilerler ve 

başparmağın phalanx distalis’inin basis’inde sonlanır (Şekil 16). Başparmağa fleksiyon 

hareketi yaptırır. Ayrıca elin fleksiyonuna yardım eder. Nervus medianus (n. interosseus 

anterior) tarafından inerve edilir (1, 23, 24, 47). 



 

27 

 

Şekil 16. M. flexor digitorum superficialis, m. flexor digitorum profundus ve m. flexor 

pollicis longus (Putz’dan, 28) 

2.2.9. Anatomik Varyasyonlar  

Canalis carpi’de çok çeşitli anatomik varyasyonlarla karşılaşılmaktadır. Bu 

varyasyonlar sinir varyasyonları, vasküler varyasyonlar ile kas ve tendon varyasyonları 

olarak sınıflandırılabilir.  

2.2.9.1. Sinir Varyasyonları  

Nervus Medianus’un Yüksekte Dallanması  

Nervus medianus canalis carpi boyunca tek bir sinir olarak ilerler ve daha sonra lig. 

carpi transversum’un distalinde parmaklara giden sinirleri oluşturmak için bölünür (9). 

Nervus medianus’un bazı vakalarda lig. carpi transversum’un proksimalinde iki dala 

ayrılması bifid median sinir olarak bilinir. Bifid median sinir %1-3.3’lük prevalans ile sık 

karşılaşılan bir varyasyondur ve genellikle persistan median arter ile birlikte görülür (5, 9, 

46, 48, 49). Nervus medianus’un üç dala ayrıldığı trifid median sinir anomalisi ise %0.5’lik 

prevalans ile nadir görülen bir varyasyon olarak bildirilmiştir (50). 
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Nervus Medianus’un Motor Dalının Varyasyonları 

Nervus medianus’un motor dalının (r. recurrens) varyasyonları ilk kez 1977’de 

Lanz tarafından bildirilmiştir (49). Motor dallar lig. carpi transversum ile ilişkisine göre 

ekstraligamentöz (Tip I), subligamentöz (Tip II) ve transligamentöz (Tip III) olarak üç 

gruba ayrılır (Şekil 17). Ekstraligamentöz tip vakaların %46’sında görülen en yaygın tiptir, 

lig. carpi transversum’un distalinde ortaya çıkar. Subligamentöz tip vakaların yaklaşık 

%31’inde görülür ve canalis carpi’nin içinde ortaya çıkar. Transligamentöz tip %23’lük 

prevalansı ile en az seyir gösteren tiptir ve lig. carpi transversum’u delerek ayrılır (5, 9, 

46). Nervus medianus bazı durumlarda retinaculum flexorum’u çaprazlayan birden çok 

motor dal verebilir (51, 52).  

 

Şekil 17.  N. medianus’un motor dalının varyasyonları. (A) N. medianus’un el ve el 

bileğinde genel seyri. (B, C) Ekstraligamentöz tip, radial taraf. (D, E) 

Subligamentöz tip. (F, G) Transligamentöz tip. (H, I) Ekstraligamentöz tip, ulnar 

taraf (Henry’den, 46)  

Nervus Medianus’un Palmar Cutaneous Dalının Varyasyonları  

Nervus medianus’un bu dalının iki varyasyonu tanımlanmıştır. İlk varyasyonda 

palmar cutaneous dal lig. carpi transversum’u delip geçen bir transligamentöz seyre 

sahiptir. İkinci varyasyonda ise bu dal n. medianus’a ulnar taraftan katılır (5, 9). 

Nervus Ulnaris’in Varyasyonları 

Nervus ulnaris, os pisiforme ve hamulus ossis hamati arasında bulunan canalis 

ulnaris’in (Guyon kanalı) içerisinden geçerek ele ulaşır (20). Ancak çok nadir olarak n. 

ulnaris’in canalis carpi içinde bulunduğu vakalar bildirilmiştir (5, 9, 53). 
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Nervus Medianus ile Nervus Ulnaris Arasındaki Bağlantılar 

Nervus medianus ve n. ulnaris arasındaki bağlantılar sonucu elin intrinsik kaslarının 

inervasyonunda farklılıklar görülebilir. Bunlardan en yaygın olanı (%40) önkolun 

proksimalinde görülen Martin-Gruber anastomozudur. Önkolun distalinde n. ulnaris’ten n. 

medianus’a katılan lifler sonucu oluşan Marinacci anastomozu nadir olarak görülebilir. 

Elin palmar kısmında n. medianus’un r. recurrens dalı ile n. ulnaris’in r. palmaris dalı 

arasındaki Riche-Cannieu anastomozu oldukça yaygın (%77-100) görülen bir 

varyasyondur (5, 9, 30, 43). 

2.2.9.2. Vasküler Varyasyonlar 

Persistan Median Arter  

Median arter, a. axillaris’ten gelişir ve embriyolojik dönemde ellerin kanlanmasını 

sağlar. İntrauterin dönemin sekizinci haftasından itibaren a. ulnaris ve a. radialis’in 

gelişmesi ile birlikte median arter geri çekilir (54, 55). Median arter’in önkolda 

embriyolojik bir kalıntı olarak bulunması persistan median arter olarak adlandırılır. 

Vakaların %1.1-16’sında rapor edilmiştir ve genellikle bifid median sinir ile birlikte 

görülmektedir (5, 9, 56).  

Superficial Ulnar Arter 

Bu bölgedeki bir diğer vasküler varyasyon superficial ulnar arter’dir. Bu anomalide 

a. ulnaris önkolda fascia antebrachii’nin derininde ve fleksor kasların yüzeyelinde seyir 

gösterir. Superficial ulnar arter %0.7-9.4 oranında prevalansa sahiptir (9, 57, 58). 

2.2.9.3. Kas ve Tendonlara Ait Varyasyonlar 

Musculus Palmaris Longus 

Musculus palmaris longus insan vücudunun en değişken kaslarından biridir. Bu 

kasın varyasyonlarının görülme sıklığı %9 olarak bildirilmiştir (59). Kasın canalis carpi’de 

iki çeşit varyasyonuna rastlanmıştır. Bunlardan birincisinde kas kanal içi tendona sahiptir 

ve kasın tendonu canalis carpi içerisinde ilerler. İkinci varyasyonda ise m. palmaris 

longus’un kas gövdesi canalis carpi içerisinde bulunur (5, 9, 59). 
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Musculus Flexor Digitorum Superficialis 

Bu kasın en sık görülen varyasyonu kas gövdesinin canalis carpi içerisinde 

uzanmasıdır. Bu varyasyonun görülme sıklığı kadınlarda %46, erkeklerde %7.8 olarak 

bildirilmiştir (5, 60). 

Musculus Lumbricalis 

Bazı vakalarda II. parmağa ait m. lumbricalis canalis carpi içerisinde m. flexor 

digitorum’un proksimalinde anormal bir başlangıca sahip olabilir (5, 9, 56). 

Linburg-Comstock Sendromu 

Linburg-Comstock anomalisi tipik olarak m. flexor pollicis longus ile II. parmağa 

ait m. flexor digitorum profundus kası arasındaki anormal tenosinoviyal bağlantı olarak 

tanımlanır. Görülme sıklığı %13-66 olarak bildirilmiştir (9, 61). 

2.3. Karpal Tünel Sendromu 

Karpal tünel sendromu (KTS) üst ekstremitenin en sık görülen periferik 

nöropatisidir. Nervus medianus’un canalis carpi’den geçerken lig. carpi transversum’un 

altında sıkışması sonucu oluşur (Şekil 18) (3, 30, 62). İlk kez 1854’te Paget tarafından, 

distal radius uç kırığı nedeniyle n. medianus’un kompresyona uğradığı bir vakada 

tanımlanmıştır (63). 1913’te Marie ve Foix retinaculum flexorum’un proksimalinde n. 

medianus’ta meydana gelen anatomik ve patolojik değişiklikleri göstermiştir (5). 

1950’lerde Phalen tarafından yapılan çalışmalar KTS’nin ilkelerini oluşturmuştur (5, 64). 

 

Şekil 18. Karpal Tünel Sendromu (65) 

Genel populasyonda prevalansı yaklaşık %3-5 olarak bildirilmiştir. Sıklıkla 40-60 

yaş arasındaki bireyleri etkiler. Kadınlarda prevalansı %5.8 iken erkeklerde %0.6’dır (4, 
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66-68). Erkeklerde görülme sıklığı yaşla birlikte artar. Kadınlarda ise en sık görüldüğü yaş 

aralığı 50-59’dur (67). Çocuklarda nadir olarak görülür (69). Dominant el fazla kullanıma 

bağlı olarak daha erken ve şiddetli olarak tutulsa da vakaların %60’ında bilateral etkilenim 

görülmektedir (4, 70, 71).  

2.3.1. Patofizyoloji  

Canalis carpi; el bileğinin farklı pozisyonları sırasında şekli değişen, sert 

osteofibröz özelliklere sahip bir yapıdır. Basınç değişikliklerine karşı genişleyebilme 

yeteneği zayıftır (72). El bileğinin tekrarlı fleksiyon ve ekstansiyon hareketleri sırasında, 

kanalın hacminin azaldığı durumlarda, kanalın içindeki yapıların kapladıkları alanın 

artması durumunda, subsinoviyal konnektif doku (SSCT) kalınlaşması ve inflamasyon 

varlığında canalis carpi’nin basıncı artar (72-74). Kanal içi basınç artışına karşı en duyarlı 

olan yapı n. medianus’tur. Karpal tünel sendromu, n. medianus’un kanal içinde kronik 

kompresyon nöropatisi olarak kabul edilir (75, 76).  

Karpal tünel sendromunun patofizyolojisi henüz tam olarak aydınlatılamamıştır 

(77). Karpal tünel sendromu patogenezinde kabul edilen en yaygın görüşler mekanik 

kompresyon, mikrovasküler yetmezlik ve vibrasyon teorileridir (75).  

Mekanik kompresyon teorisine göre n. medianus’un canalis carpi içerisinde 

kompresyonu semptomların gelişmesine neden olur. El bileğinin uzun süreli ve tekrarlı 

hareketlerinin KTS oluşumunda en önemli faktör olduğu belirtilmiştir. El bileğinin tekrarlı 

hareketleri, fleksor tendonların sinoviyal kılıflarında hipertrofiye neden olur. Kanal 

içindeki doku hacminin artması mekanik basınçta artış ile sonuçlanır. Nervus medianus 

üzerindeki mekanik basınç miyelin kılıfta değişikliklere ve aksonal yaralanmaya neden 

olur (62, 75). 

Mikrovasküler yetmezlik teorisi, n. medianus’ta kan akımının azalması sonucu 

iskemi gelişmesi ve sinir iletim hızının azalması esasına dayanır (68). Karpal tünel 

sendromu oluşumunda iskemi önemli bir yere sahiptir. Yapılan çalışmalar ile n. 

medianus’ta iletim hızının yavaşlaması, iskemik kompresyon ve bozulmuş myelinizasyon 

ile açıklanmaktadır (77). 

Vibrasyon teorisi ise titreşimli aletlerin uzun süreli kullanımının KTS’ye neden 

olacağını savunur (78). Vibrasyon ile n. medianus’un mikrovasküler akımının azaldığı, bu 

durumun sinirin iletim hızında azalmaya neden olduğu gösterilmiştir (79). 
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Nervus medianus’un enine kesit alanında artış ve özellikle canalis carpi’nin distal 

seviyesinde sinirde artmış yassılaşma oranı, KTS’li hastalarda n. medianus’ta en sık 

görülen morfolojik değişikliklerdir (68, 76). Sağlıklı bireylerle karşılaştırıldığında KTS’li 

hastalarda n. medianus’un kayma miktarı anlamlı düzeyde azalır (68, 80, 81).  

2.3.2. Etiyoloji 

Karpal tünel sendromu gelişiminde rol alan birçok etiyolojik faktör bulunmasına 

rağmen vakaların çoğu idiyopatiktir (5). 

Karpal tünel sendromu ile ilişkilendirilen risk faktörleri, kişisel ve mesleki faktörler 

olarak gruplandırılabilir. Bu faktörler Tablo 1’de özetlenmiştir (82-84). 

Tablo 1. Karpal tünel sendromu etiyolojisinde rol oynayan faktörler 

Kişisel faktörler Mesleki faktörler 

- Cinsiyet 

- Yaş 

- Obezite 

- Gebelik 

- Diabetus mellitus 

- Romatoid artrit  

- Osteoartrit 

- Hipotroidizm 

- Diyaliz  

- Sigara 

- Travma öyküsü 

- Genetik faktörler 

-      Anatomik faktörler 

- El ve el bileğinin tekrarlı aktiviteleri 

- El bileğinin pozisyonu 

- Vibrasyon maruziyeti 

- Ağır obje kaldırma 

- Artmış kavrama kuvveti 

 

 

Kadın cinsiyetin KTS için risk faktörü olduğu birçok çalışmada gösterilmiştir. 

Kadınlarda KTS’nin sık görülmesinin nedeni canalis carpi’nin daha dar ve küçük olması 

gibi anatomik farklılıklar ve hormonal faktörler ile açıklanmıştır (36, 40, 85). Artan yaş ile 

birlikte vasküler yapıda meydana gelen değişiklikler siniri kompresyona daha açık hale 

getirir ve KTS riskini artırır (85). Vücut kütle indeksi (VKİ) ve obezite KTS ile güçlü bir 

ilişki içerisindedir. VKİ’deki her bir ünitelik artış, KTS riskini %8 oranında artırır. Obez 

bireylerde canalis carpi içerisindeki artmış yağ dokusu kanal içi basıncı yükselterek KTS 

gelişimine katkıda bulunur (40, 85). 

Romatoid artrit, osteoartrit, hipotirodizm, akromegali gibi sistemik hastalıklar 

sinirin tuzaklandığı bölgede materyal birikimine neden olarak kanal içi basıncı artırır ve 
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sinir kompresyonuna neden olur. Diabetus mellitus ise direkt olarak sinir iletimi ve 

metabolizmasını etkileyerek n. medianus’un canalis carpi içinde tuzaklanmasında rol oynar 

(82, 86-88). 

Gebelik sırasında KTS görülmesi sık karşılaşılan bir durumdur. Etiyolojisi kesin 

olmamakla birlikte gebelik sırasındaki hormonal değişiklikler, sıvı retansiyonu, kilo artışı 

gibi faktörlerin canalis carpi’de lokal ödem artışına neden olduğu ve semptomların geliştiği 

düşünülmektedir (7, 89, 90). Özellikle gebeliğin son üç ayında görülür (7, 89). Genellikle 

postnatal dönemde semptomlarda kendiliğinden iyileşme gerçekleşir (7, 90). 

Distal radius uç kırığı, karpal kemiklerin kırığı, dislokasyonlar gibi el ve el bileğini 

ilgilendiren travmalar canalis carpi’yi daraltarak KTS’ye neden olabilir (40, 63, 68, 88, 

91). 

Son yıllarda yapılan çalışmalar genetik faktörlerin, canalis carpi içerisindeki 

tendonların ve diğer bağ doku yapılarının mekanik özelliklerini değiştirdiği için KTS 

etiyolojisinde önemli rol oynadığını göstermiştir. Özellikle COL5A1 ve BGN genlerindeki 

varyasyonlar KTS ile ilişkili bulunmuştur. Karpal tünel sendromlu hastaların çoğunda aile 

öyküsü bulunmuştur. Bu genetik mekanizmalar aynı zamanda KTS’nin ailesel yatkınlığı 

üzerinde de potansiyel rol oynar (92-95). Karpal tünel sendromu çocuklarda nadir 

rastlanılan bir durumdur. Çocuklarda görülen KTS vakalarında yaygın etiyoloji 

mukopolisakkaridoz ve mukolipidoz gibi lizozomal depo hastalıkları ile ilişkilidir (69). 

Canalis carpi içerisinde bildirilen anatomik varyasyonların KTS için hazırlayıcı 

faktörlerden olduğu gösterilmiştir. Nervus medianus’un bir varyasyonu olan bifid median 

sinir, sinirin kanal içindeki enine kesit alanını artırarak KTS için zemin hazırlar (48, 96). 

Ayrıca n. ulnaris’in canalis carpi içinde pozisyonlanması kanal içi basıncı artıracağı için 

KTS ile ilişkilendirilmiştir (53). Nadir de olsa n. medianus’un canalis carpi içerisinde 

sıkışmasına neden olan vasküler varyasyonlar bulunmaktadır. Bunlar arasında en yaygın 

olanı persistan median arter varlığıdır. Canalis carpi içinde anormal bir a. radialis varlığı 

%3’ten az bir prevalans ile KTS’ye neden olabilir (97). Aynı zamanda m. fleksor 

digitorum superficialis’in kas gövdesinin canalis carpi içinde bulunması, m. palmaris 

longus’un kanal içi tendon veya kas gövdesine sahip olması gibi kas ve tendon 

varyasyonları da KTS için anatomik risk faktörleri arasındadır (5, 96). Yapılan anatomik 

çalışmalar ile karpal kemiklerin şekli veya pozisyonundaki anomaliler, canalis carpi’nin 
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boyutlarının konjenital olarak küçük olması etiyolojik faktörler arasında gösterilmiştir (5, 

36, 98).  

Sağlıklı bireyler ile karşılaştırıldığında KTS’li hastalarda kanal içi basınçta artış söz 

konusudur (72, 77). Kanal içi basınç artışına neden olan durumlardan biri de el bileğinin 

pozisyonudur (83). Canalis carpi içerisindeki basınç, el bileği nötralde iken en azdır. El 

bileğinin fleksiyon ve ekstansiyonu kanal içi basıncın artmasına neden olur. Karpal tünel 

sendromlu hastalarda kanal içi basıncın el bileği fleksiyonu ile 94 mmHg’ya, ekstansiyonu 

ile 110 mmHg’ya çıktığı bildirilmiştir (75, 77). Otuz mmHg’nın üzerindeki basınçlar, n. 

medianus’un beslenmesini azaltıp venöz dönüşü kısıtlayarak; duyu ve motor aksonlarda 

demiyelizasyona ve semptomların açığa çıkmasına neden olur (5, 99). 

Birçok çalışmada tekrarlı el ve el bileği hareketleri ile aşırı kullanıma maruz 

bırakan mesleki ve çevresel durumların KTS için en önemli risk faktörleri olduğu 

kanıtlanmıştır (40). Nervus medianus üzerinde aşırı strese neden olan uzamış ve sık tekrarlı 

el bileği fleksiyon ve ekstansiyonu KTS’ye yol açan hazırlayıcı faktörlerin başında gelir. 

Özellikle kavrama kuvvetinin de gerektiği durumlarda risk daha da artar (40, 100).  

2.3.3. Semptomlar  

En sık rastlanılan semptomlar n. medianus’un inerve ettiği alanda ağrı, uyuşma, 

karıncalanma ve duyu kaybıdır (101). Ağrı el bölgesi ile sınırlı kalmayıp proksimale doğru 

önkol, kol ve omuza kadar yayılım gösterebilir (101, 102). Semptomlar özellikle geceleri 

kötüleşir ve hasta tipik olarak ellerini sallayarak rahatlatma ihtiyacı (flick sign-sallama 

belirtisi) duyar (30, 103). Ağrı ve uyuşmanın geceleri artmasının nedeni elin uzun süreli 

fleksiyon pozisyonunda kalması ve venöz dönüşün azalması sonucu n. medianus 

üzerindeki stresin artmasıdır (103).  

Karpal tünel sendromu ilerledikçe semptomlar gündüzleri de görülür. Duyusal 

şikayetler zamanla yerini objektif bulgulara bırakır. Özellikle ilk üç parmakta hipoestezi 

vardır. Daha ileri dönemlerde thenar bölgede kas atrofisi ile başparmağın abduksiyon ve 

opozisyon hareketlerinde zayıflık ortaya çıkar. Elde güçsüzlük, kavrama kuvvetinde 

azalma, beceri ve fonksiyon kaybı günlük yaşam aktivitelerinde kısıtlılığa neden olur (101, 

104, 105). 

Bazı vakalarda hastalar yalnızca belirli aktivitelerde ortaya çıkan semptomlar 

bildirir. Özellikle el bileğinin tekrarlı fleksiyon ve ekstansiyon hareketleri sırasında canalis 
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carpi içindeki basınç artışına bağlı olarak semptomların oluşması durumu dinamik KTS 

olarak adlandırılır (5, 106). 

2.3.4. Tanı  

Karpal tünel sendromu tanısı hastanın öyküsü, fizik muayene bulguları ve 

elektrofizyolojik testlerin sonuçları eşliğinde konulur (5, 6, 107). 

2.3.4.1. Öykü 

Hastanın öyküsünde ağrının tipi, şiddeti, lokalizasyonu, hangi durumlarda artıp 

azaldığı, duyusal semptomların varlığı, eşlik eden hastalıkların olup olmadığı, aile öyküsü, el 

ve el bileğini ilgilendiren geçirilmiş travma öyküsü ile mesleki koşulları sorgulanır (108). 

2.3.4.2. Fizik Muayene 

Fizik muayene; provokatif testler, duyu muayenesi ve motor muayeneyi içerir (6, 

108, 109). 

Provokatif Testler  

Provokatif testler ile canalis carpi içindeki basınç artırılarak semptomların açığa 

çıkması sağlanır. Klinikte en çok kullanılan provokatif testler Phalen ve Ters Phalen testi, 

Tinel işareti, Durkan testi, elevasyon testi ve turnike testidir (5, 30, 108). 

Duyu Muayenesi 

Nervus medianus’un duyusal liflerinin etkilenmesi ile hastalarda uyuşma, 

karıncalanma ve parestezi gibi duyusal yakınmalar oluşabilir. Duyu muayenesinde 

Semmes-Weinstein monofilament testi, iki nokta ayrımı ve vibrasyon testleri kullanılır (6, 

108). 

Motor Muayene 

Karpal tünel sendromunun ilerleyen dönemlerinde n. medianus’un motor liflerinin 

etkilenmesine bağlı olarak hastada motor bulgular ortaya çıkabilir. Motor muayenede n. 

medianus tarafından inerve edilen kasların kuvveti ve kavrama kuvveti değerlendirilir (108).  

2.3.4.3. Elektrofizyolojik Testler 

Elektrofizyolojik testler KTS tanısında altın standart olarak kabul edilir. Karpal 

tünel sendromunda elektrofizyolojik testler sinir iletim çalışmaları ve EMG’den oluşur. 

Nervus medianus uyarılarak sinirde aksiyon potansiyeli oluşturulur. Elde edilen sinyalin 
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latensi, amplitüdü ve iletim hızı değerlendirilerek n. medianus’taki lezyonun şiddeti ve 

hastalığın prognozu tespit edilir. (30, 108). 

Bunların dışında KTS tanısında el bileği radyografisi, ultrasonografi (US), 

manyetik rezonans görüntüleme (MRG) gibi görüntüleme yöntemleri de kullanılır (108). 

2.3.5. Tedavi 

Karpal tünel sendromunun tedavisi konservatif ve cerrahi olarak ikiye ayrılabilir. 

Hafif ve orta şiddetteki KTS’de konservatif tadavi seçenekleri uygulanırken ileri düzeydeki 

vakalarda cerrahi tedavi yöntemleri tercih edilmektedir. Her iki tedavi yönteminde de amaç 

canalis carpi içerisindeki artmış basıncı düzenleyerek n. medianus’un uğradığı 

kompresyonu azaltmaktır (40, 107, 110). 

2.3.5.1. Konservatif Tedavi 

KTS’nin yönetiminde ilk tercih konservatif tedavidir. Karpal tünel sendromunun 

konservatif tedavisinde el bileği splinti, medikal tedavi (non-steroid antiiflamatuar ilaçlar, 

diüretikler, oral kortikosteroidler, B6 vitamini), lokal steroid enjeksiyonu, fizyoterapi 

modaliteleri (egzersiz, mobilizasyon yöntemleri, elektroterapi ajanları, ısı ajanları, 

kinezyolojik bantlama uygulamaları) ve aktivite modifikasyonu gibi çok sayıda tedavi 

seçeneği vardır (6, 11, 40, 107, 110-112).  

2.3.5.2. Cerrahi Tedavi 

Canalis carpi gevşetme operasyonu yıllık %3.7-5.8 arasında rapor edilen prevelansı 

ile en sık gerçekleştirilen el cerrahisidir (113). Konservatif tedavinin semptomları 

gidermede yeterli olmadığı durumlarda, thenar kas atrofisi ve başparmakta opozisyon 

zayıflığı olduğu vakalarda canalis carpi’nin cerrahi olarak gevşetilmesi önerilmektedir. 

Ligamentum carpi transversum’un cerrahi olarak gevşetilmesi ile n. medianus’a canalis 

carpi içerisinde daha geniş bir alan sağlanır (40, 107, 111). 

Son zamanlarda kullanılan cerrahi teknikler açık teknik, yarı açık teknik ve 

endoskopik teknik olarak ayrılabilir. Her üç tekniğin de birbirine göre avantaj ve 

dezavantajları bulunmaktadır. Cerrahi sonrası işe dönüş süresinin daha kısa olması ve daha 

az komplikasyona sahip olması nedeni ile son yıllarda endoskopik teknik daha fazla tercih 

edilmektedir (12, 40, 107, 113, 114). 
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2.4. Anensefali 

Gelişimin üçüncü haftasının başında ektoderm kalınlaşıp nöral plağı oluşturur. 

Üçüncü haftanın sonlarına doğru, nöral plağın lateral kenarları nöral katlantıları oluşturur. 

Nöral katlantıların birleşmesi ile de beyin ve spinal kordu kapsayan santral sinir sistemini 

geliştirecek olan nöral tüp meydana gelir. Nöral tüpün hem kranial hem de kaudal uçları 

açıktır. Kranial uç gelişimin yaklaşık 25. gününde, kaudal uç ise 27. günde kapanır (13, 

115, 116). 

İntrauterin üçüncü ve dördüncü haftalarda nöral tüpün kapanma sürecini 

tamamlayamaması nöral tüp defekti (NTD) ile sonuçlanır (14, 117). Anensefali ve spina 

bifida en yaygın görülen NTD tipleridir (118). 

Anensefali nöral tüpün kranial ucunun kapanmaması sonucu oluşur (14). Her 1 000 

canlı doğumdan birinde görülen anensefali sık karşılaşılan bir anomalidir. Görülme sıklığı 

cinsiyetler ve ırklar arasında farklılık gösterir. Kız çocuklarda erkeklere göre dört kat ve 

beyaz ırkta siyah ırka göre altı kat daha fazla görülür (115). Anensefaliklerin yaklaşık 

dörtte üçü canlı doğar ve neredeyse hepsi doğumdan sonraki ilk hafta içinde ölür (115, 

117). 

Anensefalik olgularda beyin hemorajik ve fibrotik bir doku kitlesi olarak ortaya 

çıkar. Ön beyin yapıları hiç oluşmaz. Orta beyin ve pons genellikle bulunur ancak 

serebellum yoktur. Beyin dokusu kafatası ve deri ile kapatılmaz. Ortibalar sığdır ve gözler 

öne doğru çıkıntı yapar. Boyun gelişmemiş ve retrofleksiyon pozisyonundadır. Kollar 

bacaklara göre daha uzundur. Anensefalik olgularda eşlik eden kalp ve damar problemleri 

sıktır (Şekil 19) (115). 

 

Şekil 19. Anensefali (119) 
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3. GEREÇ ve YÖNTEM 

Bu çalışma Mayıs 2018 ve Aralık 2019 tarihleri arasında Karadeniz Teknik 

Üniversitesi Tıp Fakültesi Anatomi Anabilim Dalı’nda gerçekleştirildi. 

Çalışma Anatomi Anabilim Dalı laboratuvarında mevcut olan ve %10’luk formaldehit 

çözeltisi içerisinde muhafaza edilen fetus kadavraları üzerinde gerçekleştirildi. Çalışmada 

27 kadın (15 normal, 12 anensefalik) ve 11 erkek (7 normal, 4 anensefalik) olmak üzere 38 

adet fetus kadavrasının sağ ve sol olarak toplam 76 adet el bileği incelendi. Normal kadın 

fetusların üç tanesine ait altı adet el bileği çeşitli nedenlerle (daha önce diseke edilmiş olan 

ya da canalis carpi ve içeriğinin düzgün bir şekilde açığa çıkmadığı el bilekleri) çalışma 

dışı bırakıldı. 

Fetus kadavralarının ayak uzunluk ölçümleri ile el ve el bileğine ait antropometrik 

ölçümler için 0.01 mm hassasiyetli elektronik dijital kaliper (EDK) (0-150 mm) kullanıldı 

(Resim 1). Tüm ölçümler mm cinsinden kaydedildi. 

 

Resim 1. Elektronik dijital kaliper (EDK) 

Diseksiyon işlemi için muayene eldiveni, bistüri sapı ve bistüri ucu kullanıldı. Tüm 

diseksiyonlar cerrahi mikroskop (Kaps, SOM
®
 62) altında yapıldı. Fetus kadavralarının el 

bileklerinden transvers kesit elde etmek için giyotin kullanıldı. Fetus kadavralarının 

dondurulması için yatay derin dondurucu kullanıldı.  

Görüntüleme işlemi dijital fotoğraf makinesi (Canon Powershot SX610 HS) ve 

tripod (Digital Power DP-3110A) ile yapıldı. Elde edilen görüntülerin incelenmesi ve 

verilerin analizi için dizüstü bilgisayar (Casper Nirvana) kullanıldı. 

Fetus kadavralarının intrauterin yaşları ayak uzunluk ölçümü yöntemi ile belirlendi. 

Her bir fetusun en uzun ayak parmağının distaldeki en uç noktası ile topuğun arkasındaki 

en dış nokta arasındaki mesafe 0.01 mm hassasiyetli elektronik dijital kumpas kullanılarak 
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ölçüldü. Ölçüm her iki ayak için üçer kez tekrarlandı ve ölçümlerin aritmetik ortalaması 

alındı. Sonrasında sağ ve sol ayaklar için elde edilen değerlerin de aritmetik ortalaması 

alındı. Mercer ve arkadaşlarının yapmış olduğu ve haftalara göre ayak uzunluğunun 

tanımlandığı çalışma dikkate alınarak fetusların intrauterin yaşları belirlendi (120). Yapılan 

ölçümler sonucunda fetus kadavralarının intrauterin yaşlarının 21.2 ile 39.2 hafta arasında 

olduğu belirlendi. 

Fetus kadavralarının cinsiyetleri eksternal genital organlarına göre kadın ve erkek 

olarak tayin edildi. Çalışmada kullanılan fetus kadavraları NTD varlığına göre normal ve 

anensefalik olarak olarak tanımlandı. 

3.1. El ve El Bileği ile İlgili Antropometrik Ölçümlerin Yapılması 

3.1.1. El Uzunluğunun Ölçülmesi  

Fetus kadavralarının el uzunluğunu (EU) belirlemek için, III. parmağın en uç 

noktası ile distal el bileği kıvrımının orta noktası arasındaki uzaklık EDK ile ölçüldü. 

Ölçüm sağ ve sol el için üçer kez tekrarlandı. Ölçümlerin aritmetik ortalaması alınarak her 

iki elin uzunluğu ayrı ayrı belirlendi (Resim 2). 

  

Resim 2. El uzunluğu 

3.1.2. El Genişliğinin Ölçülmesi  

Fetusların el genişliğini (EG) belirlemek için II. parmağın metacarpophalangeal 

ekleminin radial tarafındaki nokta ile V. parmağın metacarpophalangeal ekleminin ulnar 
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tarafındaki nokta arasındaki uzaklık EDK kullanılarak ölçüldü. Ölçüm her iki el için üçer 

kez tekrarlandı ve ölçümlerin aritmetik ortalaması alındı. Sağ ve sol ellerin genişliği ayrı 

ayrı kaydedildi (Resim 3). 

 

Resim 3. El genişliği 

3.1.3. El Bileği Genişliğinin Ölçülmesi  

Fetus kadavralarının el bileği genişliğini (EBG) ölçmek için, distal el bileği 

kıvrımının ulnar ve radial bitiş noktaları belirlendi. Bu iki nokta arasındaki uzaklık EDK 

ile ölçüldü. Her iki el bileği için üçer kez yapılan ölçümlerin aritmetik ortalaması alındı. 

Sağ ve sol el bileklerinin genişliği ayrı ayrı kaydedildi (Resim 4). 

 

Resim 4. El bileği genişliği 



 

41 

3.1.4. El Bileği Derinliğinin Ölçülmesi  

El bileğinin derinliğini (EBD) ölçmek için, el bileğinin palmar ve dorsal yüzleri 

arasındaki yükseklik EDK ile ölçüldü. Ölçümler her iki el bileği için üçer kez tekrarlandı 

ve aritmetik ortalaması alındı. Elde edilen ölçüm sonuçları sağ ve sol el bilekleri için ayrı 

ayrı kaydedildi (Resim 5).  

 

Resim 5. El bileği derinliği 

3.2. Fetus Kadavralarının Hazırlanması 

Fetus kadavraları canalis carpi seviyesinden transvers kesit elde etmek amacıyla; 

diseksiyon masasında sırtüstü pozisyonda, kol abduksiyonda, önkol supinasyonda ve el 

bileği nötralde olacak şekilde pozisyonlandı.  

3.2.1. Diseksiyon 

Canalis carpi’nin sınırlarını belirlemek için el bileği ve elin palmar yüzü klasik 

anatomik diseksiyon yöntemleri ile diseke edildi. Palmar yüzde distal el bileği kıvrımından 

ve parmak köklerinden geçen iki adet transvers kesi uygulandı. Ardından bu iki transvers 

kesinin orta noktalarını birleştiren longitudinal bir kesi uygulandı. Kesi her iki yana doğru 

genişletilerek deri kaldırıldı ve deri altı yağ dokusu açığa çıkarıldı. Deri altı yağ dokusu 

temizlendikten sonra aponeurosis palmaris’e ulaşıldı ve canalis carpi’nin çatısını oluşturan 

lig. carpi transversum belirlendi. Ligamentum carpi transversum’un yapıştığı yerlere göre 

canalis carpi’nin seviyesi belirlendi (Resim 6). 
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Resim 6. Canalis carpi’nin seviyesinin belirlenmesi. (A) Elin palmar yüzündeki deri 

kesileri (B) Derinin kaldırılması ve lig. carpi transversum’un belirlenmesi. 

3.2.2. El Bileğinin Ayrılması ve Ellerin Dondurulması 

Diseksiyon işleminden sonra fetus kadavralarına ait el bilekleri inceleme amacıyla 

distal el bileği kıvrımının beş mm proksimalinden kesilerek ayrıldı. Bu işlemin ardından 

fetus kadavralarının elleri, bir sonraki adım olan transvers kesit alma işlemi için derin 

dondurucuda donduruldu. 

3.2.3. El Bileğinden Transvers Kesit Elde Edilmesi ve Görüntü Alınması 

Dondurulmuş el örneklerinde lig. carpi transversum’un yapışma yerine göre canalis 

carpi’nin seviyesi tanımlandı. Tanımlanan bu seviyeden giyotin ile tek seferde transvers 

kesit elde edildi (Resim 7). 

 

Resim 7. Canalis carpi seviyesinden elde edilen bir transvers kesit 
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Açığa çıkan tüm transvers kesitlerden dijital fotoğraf makinesi ile görüntü alındı. 

Her bir fetus için elde edilen görüntüler sağ ve sol el olacak şekilde gruplandırılarak 

kaydedildi. 

3.3. Görüntü Analizi 

3.3.1. ImageJ Yazılımı 

  ImageJ yazılımı, NIH Image tarafından Macintosh için geliştirilmiş bir görüntü 

analiz programıdır. Java tabanlı, açık kodlu ve ücretsiz bir yazılım olan ImageJ; Windows, 

Mac OX ve Linux işletim sistemleri için kullanılabilir. TIFF, GIF, JPEG ve DCOM gibi 

birçok görüntü formatını okuyabilir. Bu çalışmada elde edilen görüntüler JPEG 

formatındadır. 

  ImageJ yazılımı görüntüleri düzenleme, analiz etme, işleme, kaydetme ve yazdırma 

fonksiyonlarına sahiptir. Kullanıcı tarafından tanımlanmış seçimlerde alan, mesafe ve 

açıları ölçebilir. Görüntüler üzerinde çevirme, döndürme ve ölçeklendirme gibi 

dönüşümler yapabilir (121). 

ImageJ penceresinde menü çubuğu, araç çubuğu ve durum çubuğu olmak üzere üç 

temel bant vardır (Şekil 20). 

 

Şekil 20. ImageJ pencereleri 

3.3.2. ImageJ ile Ölçümlerin Yapılması  

Kaydedilen görüntüler ImageJ programında ʻʻFile>Open” seçeneği ile açıldı ve 

ölçümler için hazırlandı (Şekil 21).  

Her bir transvers kesit için ölçümler üçer kez tekrar edildi ve sonuçların aritmetik 

ortalaması alındı. Tüm ölçümler aynı kişi tarafından yapıldı. Hesaplamalar sonucu elde 

edilen değerler her bir fetus için sağ ve sol el bileği olmak üzere ayrı ayrı kaydedildi. 
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Şekil 21. ImageJ programında açılmış bir transvers kesit görüntüsü 

3.3.2.1. Canalis Carpi’nin Genişliğinin Ölçülmesi 

Canalis carpi’nin genişliği (CCG), kanalın medial ve lateral sınırları arasındaki 

maksimum uzaklık olarak kabul edildi. Bu uzaklık ImageJ programında “Straight” 

seçeneği ile serbest bir çizgi olarak işaretlendi ve “Analyze>Measure” seçeneği ile ölçüldü 

(Şekil 22). 

  

Şekil 22. ImageJ programında canalis carpi’nin genişliğinin ölçülmesi 
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3.3.2.2. Canalis Carpi’nin Yüksekliğinin Ölçülmesi 

Canalis carpi’nin yüksekliği (CCY), os capitatum’un anterior kenarı ile lig. carpi 

transversum’un posterior kenarı arasındaki maksimum uzaklık olarak kabul edildi. Bu iki 

nokta arasına “Straight” seçeneği ile serbest bir çizgi çizildi ve “Analyze>Measure” 

seçeneği ile bu uzaklık ölçüldü (Şekil 23). 

 

Şekil 23. ImageJ programında canalis carpi’nin yüksekliğinin ölçülmesi 

3.3.2.3. Canalis Carpi’nin Sınırlarının Belirlenmesi ve Enine Kesit Alanının 

Ölçülmesi  

ImageJ programında canalis carpi’nin sınırları “Poligon Selection”seçeneği ile 

işaretlenerek belirlendi. Sınırları belirlenen canalis carpi’nin enine kesit alanı 

‘’Analyze>Measure” seçeneği ile ölçüldü (Şekil 24). 
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Şekil 24. Canalis carpi’nin sınırlarının belirlenmesi ve enine kesit alanının hesaplanması 

3.3.2.4. Nervus Medianus’un Sınırlarının Belirlenmesi ve Enine Kesit Alanının 

Ölçülmesi 

ImageJ programında n. medianus’un sınırları “Poligon Selection”seçeneği ile 

işaretlenerek belirlendi. Nervus medianus’un sınırları belirlendikten sonra 

“Analyze>Measure” seçeneği ile sinirin enine kesit alanı ölçüldü (Şekil 25). 

 

Şekil 25. N. medianus’un sınırlarının belirlenmesi ve enine kesit alanının ölçülmesi 
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3.3.2.5. Musculus Flexor Pollicis Longus’un Enine Kesit Alanının Ölçülmesi 

Canalis carpi içerisinde en radial tarafta bulunan tendon olan m. fleksor pollicis 

longus’un (FPL) tendonunun enine kesit alanını ölçmek için öncelikle görüntü 

“Image>Type>8-bit” seçeneği ile siyah beyaz hale getirildi. Daha sonra 

“Image>Adjust>Threshold” seçeneği ile tendonun kapladığı alan işaretlendi ve ‘’Poligon 

Selection” seçeneği ile tendonun sınırları belirlendi. Ardından “Analyze>Measure” 

seçeneği ile FPL tendonunun enine kesit alanı ölçüldü (Şekil 26). 

 

Şekil 26. FPL’nin tendonunun enine kesit alanının ölçülmesi 

3.3.2.6. Musculus Flexor Digitorum Superficialis ve Musculus Flexor Digitorum 

Profundus’un Tendonlarının Enine Kesit Alanlarının Ölçülmesi 

Musculus fleksor digitorum superficialis (FDS) ve m. fleksor digitorum 

profundus’a (FDP) ait tendonların enine kesit alanları birlikte ölçüldü. Bunun için ImageJ 

programında “Threshold” yöntemi kullanıldı. Öncelikle görüntü “Image>Type>8-bit” 

seçeneği ile görüntü siyah beyaz hale dönüştürüldü. Daha sonra 

“Image>Adjust>Threshold” seçeneği ile FDS ve FDP’nin tendonlarının kapladığı alan 

işaretlendi. Ardından “Poligon Selection” seçeneği ile bu tendonların çevresi sınırlandırdı 

ve “Analyze>Measure” seçeneği ile tendonların enine kesit alanı ölçüldü (Şekil 27). 
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Şekil 27. FDS ve FDP’nin tendonlarının enine kesit alanının ölçülmesi 

3.3.2.7. Fleksor Tendonların Toplam Enine Kesit Alanının Ölçülmesi 

Canalis carpi içerisindeki fleksor tendonların toplam enine kesit alanının ölçmek için 

öncelikle görüntüler “Image>Type>8-bit” seçeneği ile siyah beyaz hale dönüştürüldü. 

Ardından “Image>Adjust>Threshold” seçeneği ile fleksor tendonların kapladığı tüm alan 

işaretlendi. Belirlenen bu alan “Poligon Selection” seçeneği ile sınırlandırıldı. Daha sonra 

“Analyze>Measure” seçeneği ile tüm fleksor tendonların enine kesit alanı ölçüldü (Şekil 28). 

 

Şekil 28. Fleksor tendonların toplam enine kesit alanının ölçülmesi 
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3.4. Hesaplamalar 

El ve el bileğine ait antropometrik ölçümlerin sonuçları arasında ve ImageJ 

programında yapılan ölçümlerin sonuçları arasında oran hesaplamaları yapıldı.  

3.4.1. Antropometrik Ölçümler ile İlgili Oran Hesaplamaları 

3.4.1.1. El Bileği Oranı  

El bileği oranını (EBO) belirlemek için el bileği derinliği (EBD) ile el bileği 

genişliği (EBG) değerlerlerinin oranı hesaplandı. Bunun için “Eşitlik 1” denklemi 

kullanıldı. 

 EBO = (El bileğinin derinliği)/(El bileğinin genişliği)              (Eşitlik 1) 

3.4.2. Canalis Carpi ve İçeriği ile İlgili Oran Hesaplamaları 

3.4.2.1. Canalis Carpi Oranı  

Canalis carpi’nin yüksekliğinin (CCY) genişliğine (CCG) oranı (CCO), “Eşitlik 2” 

denklemi kullanılarak hesaplandı. 

 CCO = [(Canalis carpi’nin yüksekliği)/(Canalis carpi’nin genişliği)]     (Eşitlik 2) 

3.4.2.2. Nervus Medianus’un Enine Kesit Alanının Canalis Carpi’nin Enine Kesit 

Alanına Oranı  

N. medianus’un enine kesit alanının, canalis carpi’nin enine kesit alanına oranının 

(NM/CC) yüzde cinsinden değeri, “Eşitlik 3” denklemi kullanılarak hesaplandı. 

 NM/CC = (N. medianus’un alanı/Canalis carpi’nin alanı) X 100       (Eşitlik 3) 

3.4.2.3. Musculus Fleksor Digitorum Superficialis ve Musculus Fleksor Digitorum 

Profundus’un Tendonlarının Enine Kesit Alanlarının Canalis Carpi’nin Enine Kesit 

Alanına Oranı  

Musculus fleksor digitorum superficialis ve m. fleksor digitorum profundus’un 

tendonlarının birlikte kapladıkları enine kesit alanının canalis carpi’nin enine kesit alanına 

oranını (FDS.FDP/CC) yüzde cinsinden belirtmek için “Eşitlik 4” denklemi kullanıldı. 

 FDS.FDP/CC = [(FDS ve FDP tendonlarının alanı)/Canalis carpi’nin alanı] X 100  

(Eşitlik 4) 
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3.4.2.4. Musculus Fleksor Pollicis Longus’un Tendonunun Enine Kesit Alanının 

Canalis Carpi’nin Enine Kesit Alanına Oranı  

Musculus fleksor pollicis longus’un enine kesit alanının canalis carpi’nin enine 

kesit alanına oranını (FPL/CC) yüzde cinsinden belirtmek için “Eşitlik 5” denklemi 

kullanıldı. 

 FPL/CC = [(FPL’nin alanı)/(Canalis carpi’nin alanı)] X 100            (Eşitlik5) 

3.4.2.5. Fleksor Kaslara Ait Tendonların Toplam Enine Kesit Alanının Canalis 

Carpi’nin Enine Kesit Alanına Oranı  

Canalis carpi içerisindeki fleksor tendonların toplam enine kesit alanının canalis 

carpi’nin enine kesit alanına oranını (FT/CC) yüzde cinsinden belirtmek için “Eşitlik 6” 

denklemi kullanıldı. 

 FT/CC = (FDS.FDP/CC) + (FPL/CC)                          (Eşitlik 6) 

3.4.2.6. Canalis Carpi’nin İçerdiği Yapıların Toplam Enine Kesit Alanın Canalis 

Carpi’nin Enine Kesit Alanına Oranı  

Canalis carpi’nin içerdiği yapıların toplam enine kesit alanının canalis carpi’nin 

enine kesit alanına oranını (NM.FT/CC) yüzde cinsinden belirtmek için “Eşitlik 7” 

denklemi kullanıldı. 

 NM.FT/CC = (FT/CC) + (NM/CC)                           (Eşitlik 7) 

3.4.2.7. Canalis Carpi’nin İçerdiği Yapılar Dışında Kalan Enine Kesit Alanının 

Canalis Carpi’nin Enine Kesit Alanına Oranı  

Canalis carpi’nin içerdiği yapılar dışında kalan boş enine kesit alanının canalis 

carpi’nin enine kesit alanına oranını (BA/CC) yüzde cinsinden belirtmek için “Eşitlik 8” 

denklemi kullanıldı. 

 BA/CC = 100-(NM.FT/CC)                               (Eşitlik 8) 

3.5. Verilerin Analizi 

Verilerin analiz aşamasında SPSS 23.0 istatistik paket programı kullanılmıştır. 

Değerlendirme sonuçlarının tanımlayıcı istatistikleri; sayısal değişkenler için ortalama ve 
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standart sapma olarak verilmiştir. Sayısal değişkenlerin normal dağılımları Shapiro Wilk 

testi ile değerlendirilmiştir. Verilerin normal dağılıma uymadığı bağımsız ikili gruplar 

arasında ölçümsel değişkenlerin karşılaştırmalarında Mann Whitney U testi, normal 

dağılıma uyduğu bağımsız iki grubun karşılaştırılmasında Student-T testi kullanılmıştır. 

İstatistiksel alfa anlamlılık seviyesi p<0.05 olarak kabul edilmiştir. 
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4. BULGULAR 

Bu çalışmada 35 adet fetus kadavrasının (19 normal, 16 anensefalik) sağ ve sol 

olmak üzere toplam 70 adet el ve el bileği incelendi. Her bir el ve el bileği için 

antropometrik ölçümler ile canalis carpi ve içeriğine ait oransal hesaplamalar yapıldı. 

Ölçümler ve hesaplamalar sonucunda elde edilen değerler; cinsiyet, nöral tüp 

defekti varlığı, intrauterin yaş ve lateralizasyona göre gruplandırılarak istatistiksel olarak 

karşılaştırıldı. 

4.1. Yaş Ortalamaları ile İlgili Sonuçlar  

4.1.1. Kadın ve Erkek Fetusların Yaş Ortalamaları ile İlgili Sonuçlar 

Fetusların cinsiyetlerine göre yaş ortalamalarının karşılaştırılması Tablo 2’de 

gösterilmiştir. 

Tablo 2. Kadın ve erkek fetusların yaş ortalamalarının karşılaştırılması 

 Kadın  Erkek 

 n Ort±SD n Ort±SD p 

Yaş (Hafta) 24 27.68±4.59 11 28.83±4.88 0.401 

 

Fetusların yaş ortalamaları cinsiyetler arasında karşılaştırıldığında; yaş ortalamaları 

açısından kadın ve erkek fetuslar arasındaki fark istatistiksel olarak anlamlı değildi 

(p>0.05) (Tablo 2). 

4.1.2. Normal ve Anensefalik Fetusların Yaş Ortalamaları ile İlgili Sonuçlar 

Normal ve anensefalik fetusların yaş ortalamalarının karşılaştırılması Tablo 3’te 

gösterilmiştir. 

Tablo 3. Normal ve anensefalik fetusların yaş ortalamalarının karşılaştırılması 

 Normal  Anensefalik 

 n Ort±SD n Ort±SD p 

Yaş (Hafta) 19 27.73±5.17 16 28.42±4.06 0.168 
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Fetusların yaş ortalamaları normal ve anensefalik fetuslar arasında 

karşılaştırıldığında; yaş ortalamaları açısından normal ve anensefalik fetuslar arasındaki 

fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 3). 

4.1.3. Normal Fetusların Cinsiyetlerine Göre Yaş Ortalamaları ile İlgili Sonuçlar 

Normal fetusların cinsiyetlerine göre yaş ortalamalarının karşılaştırılması Tablo 

4’te gösterilmiştir. 

Tablo 4. Normal fetusların cinsiyetlerine göre yaş ortalamalarının karşılaştırılması 

 Normal Kadın  Normal Erkek 

 n Ort±SD n Ort±SD p 

Yaş (Hafta) 12 28.09±5.67 7 27.11±4.54 0.500 

 

Normal fetusların yaş ortalamaları kadın ve erkek fetuslar arasında 

karşılaştırıldığında; yaş ortalamaları açısından normal kadın ve normal erkek fetuslar 

arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 4). 

4.1.4. Anensefalik Fetusların Cinsiyetlerine Göre Yaş Ortalamaları ile İlgili Sonuçlar 

Anensefalik fetusların cinsiyetlerine göre yaş ortalamalarının karşılaştırılması 

Tablo 5’te gösterilmiştir. 

Tablo 5. Anensefalik fetusların cinsiyetlerine göre yaş ortalamalarının karşılaştırılması 

 Anensefalik Kadın  Anensefalik Erkek 

 n Ort±SD n Ort±SD p 

Yaş (Hafta) 12 27.28±3.40 4 31.85±4.38 0.352 

 

Anensefalik fetusların yaş ortalamaları kadın ve erkek fetuslar arasında 

karşılaştırıldığında; yaş ortalamaları açısından anensefalik kadın ve anensefalik erkek 

fetuslar arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 5). 
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4.2. El ve El Bileği ile İlgili Antropometrik Ölçümlerin Sonuçları  

4.2.1. El ve El Bileği ile İlgili Antropometrik Ölçümlerin Cinsiyetler Arasında 

Karşılaştırılması 

El ve el bileği ile ilgili antropometrik ölçümlerin sonuçlarının cinsiyetler arasında 

karşılaştırılması Tablo 6’da gösterilmiştir. 

Tablo 6.  El ve el bileği ile ilgili antropometrik ölçümlerin sonuçlarının cinsiyetler arasında 

karşılaştırılması  

 Kadın Erkek 

 n Ort±SD n Ort±SD  p 

Sağ EU 24 41.300±7.015 11 43.040±6.201 0.486 

Sol EU 24 41.547±7.297 11 42.832±5.994  0.614 

Sağ EG 24 20.439±5.417 11 23.167±5.926 0.188 

Sol EG 24 20.357±5.138 11 22.924 ±5.994  0.202 

Sağ EBG 24 16.160±5.060 11 17.570±5.766  0.468 

Sol EBG 24 15.805±5.030 11 17.597±5.454  0.348 

Sağ EBD 24 11.560±4.243 11 13.810±4.734  0.169 

Sol EBD 24 11.383±4.730 11 13.717±5.099  0.195 

Sağ EBO 24 0.709±0.115 11 0.783±0.087  0.067 

Sol EBO 24 0.715±0.181 11 0.764±0.098 0.409 

  

 Fetusların el ve el bileklerine ait antropometrik ölçümlerin sonuçları cinsiyetler 

arasında karşılaştırıldığında; sağ EU, sol EU, sağ EG, sol EG, sağ EBG, sol EBG, sağ 

EBD, sol EBD ölçümleri ile sağ EBO ve sol EBO hesaplamaları açısından kadın ve erkek 

fetuslar arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 6). 

4.2.2. El ve El Bileği ile İlgili Antropometrik Ölçümlerin Normal ve Anensefalik 

Fetuslar Arasında Karşılaştırılması 

El ve el bileği ile ilgili antropometrik ölçümlerin sonuçlarının normal ve 

anensefalik fetuslar arasında karşılaştırılması Tablo 7’de gösterilmiştir. 
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Tablo 7. El ve el bileği ile ilgili antropometrik ölçümlerin sonuçlarının normal ve 

anensefalik fetuslar arasında karşılaştırılması  

 Normal Anensefalik 

 n Ort±SD n Ort±SD  p 

Sağ EU 19 41.192±7.188 16 42.624±6.279 0.539 

Sol EU 19 41.636±7.420 16 42.325±6.331 0.772 

Sağ EG 19 20.228±5.733 16  22.564±5.436 0.228 

Sol EG 19 20.336±5.477 16 22.147±5.464 0.337 

Sağ EBG 19 15.390±5.069 16 18.040±5.249 0.246 

Sol EBG 19 15.395±4.939 16 17.525±5.324 0.229 

Sağ EBD 19 11.440±4.385 16 13.250±4.487 0.238 

Sol EBD 19 10.926±4.938 16 13.531±4.604 0.154 

Sağ EBO 19 0.733±0.100 16 0.732±0.127 0.969 

Sol EBO 19 0.690±0.140 16 0.778±0.173 0.106 

 

Fetusların el ve el bileklerine ait antropometrik ölçümlerin sonuçları normal ve 

anensefalik fetuslar arasında karşılaştırıldığında; sağ EU, sol EU, sağ EG, sol EG, sağ 

EBG, sol EBG, sağ EBD ve sol EBD ölçümleri ile sağ EBO ve sol EBO hesaplamaları 

açısından normal ve anensefalik fetuslar arasındaki fark istatistiksel olarak anlamlı değildi 

(p>0.05) (Tablo 7). 

4.2.3. El ve El Bileği ile İlgili Antropometrik Ölçümlerin İntrauterin Yaş Grupları 

Arasında Karşılaştırılması 

El ve el bileği ile ilgili antropometrik ölçümlerin sonuçlarının intrauterin yaş 

grupları arasında karşılaştırılması Tablo 8’de gösterilmiştir. 
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Tablo 8. El ve el bileği ile ilgili antropometrik ölçümlerin sonuçlarının intrauterin yaş 

grupları arasında karşılaştırılması  

 30 Haftadan Küçük 30 Haftadan Büyük  

 n Ort±SD n Ort±SD  p 

Sağ EU 23 38.480±4.733 12 48.299±5.101 0.001* 

Sol EU 23 38.353±4.509 12 48.848±5.051 0.001* 

Sağ EG 23 18.474±3.886 12 26.705±4.429 0.001* 

Sol EG 23 18.388±3.629 12 26.485±4.365 0.001* 

Sağ EBG 23 13.920±3.447 12 21.740±4.183 0.001* 

Sol EBG 23 13.744±3.314 12 21.399±4.264 0.001* 

Sağ EBD 23 10.010±3.300 12 16.600±2.929 0.001* 

Sol EBD 23 9.663±3.890 12 16.819±2.681 0.001* 

Sağ EBO 23 0.714±0.124 12 0.768±0.073 0.173 

Sol EBO 23 0.697±0.183 12 0.794±0.703 0.056 

*p<0,05 

Fetusların el ve el bileklerine ait antropometrik ölçümler intrauterin yaş grupları 

arasında karşılaştırıldığında; sağ EU, sol EU, sağ EG, sol EG, sağ EBG, sol EBG, sağ EBD 

ve sol EBD ölçümlerindeki fark istatistiksel olarak anlamlıydı (p<0.05). Sağ EU, sol EU, 

sağ EG, sol EG, sağ EBG, sol EBG, sağ EBD ve sol EBD ölçümlerinin; 30 haftadan büyük 

fetuslarda, 30 haftadan küçük fetuslara göre anlamlı derecede daha büyük olduğu belirlendi 

(p<0.05) (Tablo 8). Sağ EBO ve sol EBO hesaplamaları açısından intrauterin yaş grupları 

arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 8). 

4.2.4. El ve El Bileği ile İlgili Antropometrik Ölçümlerin Lateralizasyona Göre 

Karşılaştırılması 

El ve el bileği ile ilgili antropometrik ölçümlerin sağ ve sol taraf arasında 

karşılaştırılması Tablo 9’da gösterilmiştir. 

Tablo 9. El ve el bileği ile ilgili antropometrik ölçümlerin lateralizasyona göre 

karşılaştırılması  

 Sağ Taraf  Sol Taraf 

 n Ort±SD n Ort±SD  p 

EU 35 41.847±6.728 35 41.951±6.852 0.949 

EG 35 21.296±5.642 35 21.164±5.467 0.921 

EBG 35 16.602±5.248 35 16.368±5.155 0.852 

EBD 35 12.266±4.460 35 12.117±4.898 0.833 

EBO 35 0.733±0.111 35 0.730±0.160 0.942 
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Fetusların el ve el bileklerine ait antropometrik ölçümlerin sonuçları lateralizasyona 

göre karşılaştırıldığında; EU, EG, EBG, EBD ölçümleri ve EBO açısından sağ ve sol taraf 

arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 9). 

4.3. Canalis Carpi ve İçeriği ile İlgili Oran Hesaplamalarının Sonuçları 

4.3.1. Canalis Carpi ve İçeriği ile İlgili Oran Hesaplamalarının Sonuçlarının 

Cinsiyetler Arasında Karşılaştırılması 

Canalis carpi ve içeriği ile ilgili oran hesaplamalarının sonuçlarının cinsiyetler 

arasında karşılaştırılması Tablo 10’da gösterilmiştir.  

Tablo 10. Canalis carpi ve içeriği ile ilgili oran hesaplamalarının cinsiyetler arasında 

karşılaştırılması 

 Kadın Erkek 

 n Ort±SD n Ort±SD  p 

Sağ CCO 24 0.392±0.074 11 0.372±0.063 0.440 

Sol CCO 24 0.419±0.083 11 0.412±0.097 0.838 

Sağ NM/CC 24 7.401±1.775 11 8.100±1.938 0.301 

Sol NM/CC 24 7.470±1.756 11 7.500±1.759 0.963 

Sağ FDS.FDP/CC 24 37.761±6.558 11 42.627±9.205 0.082 

Sol FDS.FDP/CC 24 39.030±6.315 11 39.196±7.673 0.946 

Sağ FPL/CC 24 5.600±1.474 11 6.148±9.205 0.281 

Sol FPL/CC 24 5.417±1.727 11 6.098±1.492 0.268 

Sağ FT/CC 24 43.361±6.779 11 48.754±8.757 0.049* 

Sol FT/CC 24 44.451±6.262 11 45.296±8.720 0.746 

Sağ NM.FT/CC 24 50.762±7.557 11 56.855±8.482 0.041* 

Sol NM.FT/CC 24 52.461±7.471 11 53.451±9.509 0.741 

Sağ BA/CC 24 49.237±7.557 11 43.145±8.481 0.041* 

Sol BA/CC 24 47.517±7.503 11 47.414±9.332 0.972 

*p<0.05  

Canalis carpi ve içeriği ile ilgili oran hesaplamaları cinsiyetler arasında 

karşılaştırıldığında; sağ FT/CC, sağ NM.FT/CC ve sağ BA/CC oranlarındaki fark 

istatistiksel olarak anlamlıydı (p<0.05). Sağ FT/CC oranının erkek fetuslarda kadın 

fetuslara göre istatistiksel olarak anlamlı derecede daha büyük olduğu bulundu (p<0.05). 

Sağ NM.FT/CC oranının erkek fetuslarda kadın fetuslara göre istatistiksel olarak anlamlı 

derecede daha büyük olduğu belirlendi (p<0.05). Sağ BA/CC oranının ise kadın fetuslarda 

erkek fetuslara göre istatistiksel olarak anlamlı derecede daha büyük olduğu bulundu 
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(p<0.05). Diğer oranlar cinsiyetlere göre karşılaştırıldığında ise kadın ve erkek fetuslar 

arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 10). 

4.3.2. Canalis Carpi ve İçeriği ile İlgili Oran Hesaplamalarının Normal ve 

Anensefalik Fetuslar Arasında Karşılaştırılması 

Canalis carpi ve içeriği ile ilgili oran hesaplamalarının sonuçlarının normal ve 

anensefalik fetuslar arasında karşılaştırılması Tablo 11’de gösterilmiştir. 

Tablo 11. Canalis carpi ve içeriği ile ilgili oran hesaplamalarının normal ve anensefalik 

fetuslar arasında karşılaştırılması 

 Normal Anensefalik 

 n Ort±SD n Ort±SD  p 

Sağ CCO 19 0.389±0.072 16 0.382±0.071 0.755 

Sol CCO 19 0.439±0.080 16 0.390±0.080 0.094 

Sağ NM/CC 19 7.647±2.028 16 7.590±1.626 0.929 

Sol NM/CC 19 7.656±1.656 16 7.269±1.848 0.518 

Sağ FDS.FDP/CC 19 40.315±8.192 16 38.073±7.134 0.399 

Sol FDS.FDP/CC 19 39.847±7.864 16 38.175±4.957 0.467 

Sağ FPL/CC 19 5.921±1.147 16 5.595±1.629 0.494 

Sol FPL/CC 19 5.543±1.733 16 5.736±1.633 0.738 

Sağ FT/CC 19 46.239±8.130 16 43.651±7.281 0.333 

Sol FT/CC 19 45.390±8.182 16 43.917±5.439 0.543 

Sağ NM.FT/CC 19 53.887±8.637 16 51.240±7.785 0.352 

Sol NM.FT/CC 19 54.108±9.083 16 51.186±6.512 0.291 

Sağ BA/CC 19 46.112±8.637 16 48.759±7.785 0.352 

Sol BA/CC 19 46.367±9.060 16 48.813±6.512 0.374 

 

Canalis carpi ve içeriği ile ilgili oran hesaplamaları normal ve anensefalik fetuslar 

arasında karşılaştırıldığında; sağ CCO, sol CCO, sağ NM/CC, sol NM/CC, sağ 

FDS.FDP/CC, sol FDS.FDP/CC, sağ FPL/CC, sol FPL/CC, sağ FT/CC, sol FT/CC, sağ 

NM.FT/CC, sol NM.FT/CC, sağ BA/CC ve sol BA/CC oranları açısından normal ve 

anensefalik fetuslar arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 11). 

4.3.3. Canalis Carpi ve İçeriği ile İlgili Oran Hesaplamalarının Sonuçlarının 

İntrauterin Yaş Grupları Arasında Karşılaştırılması  

Canalis carpi ve içeriği ile ilgili oran hesaplamalarının intrauterin yaş grupları 

arasında karşılaştırılması Tablo 12’de gösterilmiştir. 
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Tablo 12. Canalis carpi ve içeriği ile ilgili oran hesaplamalarının intrauterin yaş grupları 

arasında karşılaştırılması 

30 Haftadan Küçük 30 Haftadan Büyük 

 n Ort±SD n Ort±SD p 

Sağ CCO 23 0.385±0.070 12 0.389±0.074 0.872 

Sol CCO 23 0.415±0.099 12 0.420±0.061 0.876 

Sağ NM/CC 23 7.437±1.699 12 7.973±2.088 0.325 

Sol NM/CC 23 7.422±1.868 12 7.589±1.504 0.790 

Sağ FDS.FDP/CC 23 40.369±8.594 12 37.223±5.326 0.257 

Sol FDS.FDP/CC 23 39.253±7.216 12 38.756±5.708 0.838 

Sağ FPL/CC 23 5.811±1.390 12 5.698±1.409 0.822 

Sol FPL/CC 23 5.757±1.729 12 5.390±1.582 0.544 

Sağ FT/CC 23 46.170±8.541 12 42.922±5.682 0.245 

Sol FT/CC 23 45.014±7.461 12 44.146±6.303 0.734 

Sağ NM.FT/CC 23 53.607±9.021 12 50.895±6.497 0.364 

Sol NM.FT/CC 23 52.439±8.528 12 53.410±7.312 0.740 

Sağ BA/CC 23 46.39±9.021 12 49.104±6.497 0.364 

Sol BA/CC 23 47.974±8.398 12 46.547±7.373 0.623 

 

Canalis carpi ve içeriği ile ilgili oran hesaplamaları intrauterin yaş grupları arasında 

karşılaştırıldığında; sağ CCO, sol CCO, sağ NM/CC, sol NM/CC, sağ FDS.FDP/CC, sol 

FDS.FDP/CC, sağ FPL/CC, sol FPL/CC, sağ FT/CC, sol FT/CC, sağ NM.FT/CC, sol 

NM.FT/CC, sağ BA/CC ve sol BA/CC oranları açısından 30 haftadan küçük ve 30 

haftadan büyük fetuslar arasındaki fark istatistiksel olarak anlamlı değildi (p>0.05) (Tablo 

12). 

4.3.4. Canalis Carpi ve İçeriği ile İlgili Oran Hesaplamalarının Sonuçlarının 

Lateralizasyona Göre Karşılaştırılması 

Canalis carpi ve içeriği ile ilgili oran hesaplamalarının sağ ve sol taraf arasında 

karşılaştırılması Tablo 13’te gösterilmiştir. 
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Tablo 13. Canalis carpi ve içeriği ile ilgili oran hesaplamalarının lateralizasyona göre 

karşılaştırılması 

Sağ Taraf Sol Taraf 

 n Ort±SD n Ort±SD p 

CCO 35 0.386±0.071 35 0.417±0.087 0.111 

NM/CC 35 7.621±1.829 35 7.479±1.731 0.740 

FDS. FDP/CC 35 39.290±7.698 35 39.082±6.655 0.904 

FPL/CC 35 5.772±1.376 35 5.631±1.666 0.701 

FT/CC 35 45.056±7.752 35 44.717±7.003 0.848 

NM. FT/CC 35 52.677±8.248 35 52.772±8.035 0.961 

BA/CC 35 47.322±8.247 35 47.485±7.981 0.933 

 

Canalis carpi ve içeriğine ait oran hesaplamaları fetusların sağ ve sol tarafları 

arasında karşılaştırıldığında; CCO, NM/CC, FDS.FDP/CC, FPL/CC, FT/CC, NM.FT/CC 

ve BA/CC oranları açısından sağ ve sol taraf arasındaki fark istatistiksel olarak anlamlı 

değildi (p>0.05) (Tablo 13). 
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5. TARTIŞMA ve SONUÇ 

Nervus medianus’un canalis carpi’den geçerken lig. carpi transversum’un altında 

sıkışmasıyla oluşan KTS, üst ekstremitenin en sık karşılaşılan periferik nöropatisidir (30). 

Karpal tünel sendromu oluşumuna zemin hazırlayan birçok kişisel ve çevresel risk faktörü 

bildirilmiş olsa da etiyolojisi ve patogenezi henüz tam olarak aydınlatılamamıştır (40, 87). 

Canalis carpi’nin şekli ve boyutu gibi anatomik faktörler ile kanal içerisinde bildirilen 

anatomik varyasyonların KTS için hazırlayıcı faktörlerden olduğu ortaya konulmuştur. Bu 

anatomik ve morfolojik faktörler canalis carpi’nin içeriğindeki oluşumlara sağladığı alan 

açısından KTS etiyolojisinde önemli rol oynamaktadır (9, 10). Bu çalışmada fetus 

kadavralarında el ve el bileği ile ilgili antropometrik ölçümler ile; canalis carpi ve içeriği 

ile ilgili oran hesaplamaları yapılmıştır. Elde edilen veriler; fetusların cinsiyetlerine, nöral 

tüp defekti varlığına, intrauterin yaşa ve lateralizasyona göre karşılaştırılarak gruplar 

arasındaki farklılıklar araştırılmıştır.  

Literatürde canalis carpi anatomisini inceleyen erişkin kadavra çalışmaları 

bulunmaktadır. Ancak literatür konu ile ilgili fetus kadavrası çalışmasından yoksundur. 

Erişkin bireylerin maruz kaldığı dış faktörlerin canalis carpi’nin anatomik yapısında 

değişikliklere yol açıp KTS için risk oluşturduğu bilinmektedir. Bu çalışma canalis 

carpi’nin anatomisinin çevresel risk faktörlerine maruz kalmayan fetus kadavralarında 

daha objektif olarak incelenebileceği düşüncesi ile planlanmıştır. Çalışmamız, canalis carpi 

ve içeriğini oluşturan n. medianus ve fleksor tendonlarla ilgili alan ölçümleri ve oran 

hesaplamalarının incelendiği literatürdeki ilk fetus kadavrası çalışmasıdır. 

Literatüre bakıldığında canalis carpi ile ilgili kadavra çalışmalarının erişkin 

kadavralar üzerinde yapıldığı görülmektedir. Lee ve ark. beş adet erkek kadavra ile yapmış 

oldukları çalışmada kadavraların yaş ortalamaları 66.2 idi (122). Li ve ark. canalis 

carpi’deki morfolojik değişiklikleri incelemek amacıyla taze donmuş el örnekleri üzerinde 

çalışmışlardır. Çalışmaya dahil edilen sekiz adet erişkin kadavranın yaş ortalamalarını 

54.6±5.9 olarak belirlemişlerdir (35). Benzer şekilde Kim ve ark. yaş ortalamaları 56.4±6.7 

olan dokuz adet erkek kadavranın canalis carpi’lerini incelemişlerdir (123). Literatürde 

canalis carpi ve içeriğinin kesitsel alanı ile ilgili fetus kadavrası çalışmasına 

rastlanmamıştır.  
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Literatürde hasta ve sağlıklı grupların antropometrik özelliklerinin karşılaştırıldığı 

çalışmaların çoğunda; el ve el bileği boyutlarının KTS gelişimine katkıda bulunabileceği 

bildirilmiştir (124-126). 

Moghtaderi ve ark. 128 KTS’li hasta ve 109 sağlıklı gönüllü arasında yaptıkları 

karşılaştırmada EBO’nun kadın grupta anlamlı derecede daha yüksek olduğunu 

göstermişlerdir. Elde ettikleri bulgular ile kadın cinsiyetin KTS için bir risk faktörü olduğu 

sonucuna varmışlardır (127). 

Galea ve ark. KTS’li hastalarda sağlıklılara göre EBO’nun daha düşük olduğunu; 

buna bağlı olarak el ve el bileğinin daha fazla kare şekilli olduğunu bulmuşlardır. Kare 

şekilli el bileğinin canalis carpi’de de kare boyutları yansıtabileceği için n. medianus’un 

tünel içinde sıkışmasına neden olacağı sonucuna varmışlardır (128). Chiotis ve ark. n. 

medianus iletimi ile el-el bileği boyutları ve kanalın ultrasonografik ölçümleri arasındaki 

ilişkiyi araştırmışlardır. Elde ettikleri sonuçlar literatürdeki çoğu çalışma gibi kare şekilli 

ele neden olan el ve el bileği boyutlarının KTS ile ilişkisini ortaya koymuştur (129). 

Lim ve ark. 67 KTS’li hasta ve 67 sağlıklı gönüllünün el bileği ölçümlerini 

karşılaştırmış; 0.70 ve üzerindeki EBO değerinin idiyopatik KTS ile anlamlı ölçüde ilişkili 

olduğunu bulmuşlardır (130). Bizim çalışmamızda fetus kadavralarının EBO değerleri 

hesaplanmış; ortalama EBO değerleri sağ EBO için 0.733±0.111 ve sol EBO için 

0.730±0.160 olarak bulunmuştur. Elde ettiğimiz ortalama EBO değerleri Lim ve ark. 

çalışmalarında belirttikleri EBO değerleri ile benzerlik göstermektedir.  

Kamolz ve ark. KTS’li hastalar ve sağlıklı gönüllüler arasında el, el bileği ve 

canalis carpi’nin boyutlarını karşılaştırmış; hasta grupta EBO, CCO ve EG’nin daha 

yüksek olduğunu bulmuşlardır. Elde ettikleri bulgulara dayanarak el bileği ve canalis carpi 

anatomisinin KTS gelişiminde etkili olduğu sonucuna varmışlardır (131). Benzer şekilde 

Moghtaderi ve ark. 109 KTS’li hasta ve 62 sağlıklı gönüllü kadın ile yaptıkları çalışmada 

EBO’nun KTS’li grupta anlamlı derecede daha yüksek olduğunu ve artmış EBO’nun KTS 

için risk faktörü olduğunu belirtmişlerdir (127). 

Geçmişteki çalışmalarda kadın cinsiyetin KTS için güçlü bir risk faktörü olduğu 

belirtilmiştir (85, 132). Karpal tünel sendromunun kadınlarda daha sık görülmesi; elin ve 

canalis carpi’nin boyutlarının erkeklere göre daha küçük olması, hormonal faktörler ve 

gebelik döneminde meydana gelen değişiklikler ile açıklanmaktadır (85, 133, 134). Bunun 



 

63 

aksine literatürde; daha küçük el ve el bileği boyutlarının, kadınları KTS’ye daha yatkın 

hale getirmede önemli ölçüde katkı sağlamadığını bildiren çalışmalar da mevcuttur (72). 

Peterson ve ark. 2013 yılında yapmış oldukları erişkin kadavra çalışmasında canalis 

carpi’nin enine kesit alanının ve genişliğinin kadın kadavralarda; canalis carpi oranının ise 

erkek kadavralarda daha küçük olduğunu bulmuşlardır. Buna göre kadın kadavraların canalis 

carpi boyutlarının erkek kadavralara göre daha küçük olduğu sonucuna varmışlardır (135). 

Pacek ve ark. 10 adet taze donmuş kadavra el örneği üzerinde yaptıkları çalışmada 

canalis carpi’nin kadınlarda daha dar olduğu ve enine kesit alanının daha küçük olduğu; 

aynı zamanda canalis carpi’nin içeriğinin de kadınlarda daha küçük olduğu sonucuna 

varmışlardır (36). Çalışmamızda canalis carpi’nin içeriğini oluşturan yapıların enine kesit 

alanlarının canalis carpi’nin enine kesit alanına oranları hesaplanmıştır. Elde ettiğimiz 

verilere göre FT/CC ve NM.FT/CC oranlarının kadın fetuslarda erkeklere göre anlamlı 

derecede daha küçük olduğu görülmüştür (p<0.05). Sonuçlarımız canalis carpi’nin içeriğini 

oluşturan yapıların alanları açısından Pacek ve ark. sonuçları ile benzerlik göstermektedir. 

Lakshminarayanan ve ark. carpal ark morfolojisinde cinsiyet farklılıklarını 

belirlemek için 20 sağlıklı gönüllü ile yaptıkları araştırmada; carpal ark yüksekliğinin, 

canalis carpi oranının ve canalis carpi’nin enine kesit alanının kadınlarda daha küçük 

olduğu bulunmuştur (136). Bizim çalışmamızda canalis carpi’nin yüksekliği ile 

genişliğinin oranı (CCO) kadın ve erkek fetuslar arasında anlamlı fark göstermemiştir. 

Literatürde; artan yaş ile KTS riskini ilişkilendiren çalışmalar mevcuttur. İlerleyen 

yaş ile KTS riskinin artmasına; yaşlanmadan kaynaklı vasküler anomaliler, akson kaybı, 

sinir iletiminin azalması ve kanal anatomisindeki değişikliklerin neden olduğu 

bildirilmiştir (137). Karpal tünel sendromunun çocuklarda nadir olarak görüldüğü kabul 

edilir. Çocuklardaki KTS etiyolojisi en sık lizozomal depo hastalıkları ile açıklanmıştır. 

Bunun dışında literatürde; yer kaplayan lezyonlar, vasküler malformasyonlar ve 

nörofibromanın neden olduğu pediatrik KTS vakaları da rapor edilmiştir (138). 

Kömürcü ve ark. KTS şiddeti ve yaş arasında anlamlı ilişki olduğunu, yaş ile 

birlikte KTS riskinin arttığını söylemişlerdir (139). Pierre-Jerome ve ark. canalis carpi 

anatomisinde yaşa bağlı olarak meydana gelen değişiklikleri araştırmak amacıyla 

asemptomatik 57 kadın gönüllünün 114 el bileğinin MRG sonuçlarını incelemişlerdir. Yaş 

grupları arasında yapılan karşılaştırmaya göre tünelin; 45 yaş üzerindeki grupta 25-45 yaş 

arasındaki genç gruba göre daha geniş olduğunu bulmuşlardır (140). Bizim çalışmamızda 
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canalis carpi ve içeriği ile ilgili oran hesaplamalarının yaş grupları arasında anlamlı fark 

göstermediği görülmüştür. 

Son zamanlarda KTS çeşitli mesleki faktörler ile ilişkilendirilmiştir. Tekrarlı 

aktivitelere dayanan mesleklere sahip bireylerde sıklıkla KTS teşhis edilmiştir. Bu açıdan 

KTS teknolojik ve mesleki hastalıklar arasında sayılmaktadır (10). Ancak litaeratürde; 

tekrarlı aktivite ve pozisyon ile ilgili mesleki faktörlerin, n. medianus’un canalis carpi’de 

sıkışmasına yol açabileceği ile ilgili tartışmalı sonuçlar vardır. Bilgisayar, klavye ve fare 

kullanımının yaygınlaşmasının; el bileğinin nötral olmayan pozisyonda kalmasına bağlı 

olarak özellikle ofis çalışanlarında KTS riskini artırdığını bildiren çalışmalar mevcuttur 

(40, 141). Bu sonuçlara karşın literatürde bilgisayar, klavye ve fare kullanımının KTS 

oluşumuna etki etmediğini bildiren araştırmalar da mevcuttur (142). 

Karpal tünel sendromunda semptomlar genellikle bilateral olarak görülür. 

Semptomlar dominant elde fazla kullanıma bağlı olarak daha erken ve daha şiddetli olarak 

ortaya çıkar. Ancak ilerleyen dönemde dominant olmayan elde de sıklıkla şikayetlerin 

geliştiği bildirilmiştir (143). Her ne kadar KTS’li hastalar bilateral bulgulara sahip olsa da 

literatürde KTS’nin el dominansı ile olan ilişkisini araştıran az sayıda çalışma 

bulunmaktadır. Bunun yanı sıra literatürde; canalis carpi morfolojisini sağ ve sol el 

arasında karşılaştırmalı olarak inceleyen herhangi bir çalışmaya rastlanılmamıştır. 

Thomsen ve ark. tekrarlı el aktivitelerinin kullanıldığı işlerde çalışan bireyler ile 

yaptıkları çalışmada, KTS’nin genel prevalansının dominant elde %1.6 ve dominant 

olmayan elde %0.7 olduğunu bularak; yüksek düzeyde tekrarlı aktivitelerin özellikle 

dominant elde KTS ile ilişkisini açığa çıkarmışlardır (144). 

Zambelis ve ark. el dominansının dağılımının sağ ve sol KTS’li hastalarda farklı 

olduğunu ortaya koymuşlardır. Sağ dominant elin sağ KTS için beş kat daha yüksek risk 

taşıdığı; buna karşın sol dominant elin sol KTS için 13 kat riskle ilişkilendirildiğini 

bildirmişlerdir (145). 

Padua ve ark. bilateral KTS semptomlarının insidansını belirlemek ve tek taraflı 

KTS’de asemptomatik eldeki nörofizyolojik değişiklikleri araştırmak amacıyla 133 KTS’li 

hastayı incelemişlerdir. Bilateral KTS insidansını %87 olarak belirlemiş ve asemptomatik 

ellerin yaklaşık yarısında n. medianus’ta bozulmuş nörofizyolojik bulgular 

gözlemlemişlerdir. Tek taraflı KTS’li hastaların takibinde ise vakaların çoğunda ilerleyen 

dönemde etkilenmemiş elde de semptomların geliştiğini söylemişlerdir (84). 
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Jaeschke ve ark. yayınlamış oldukları sistematik bir derlemede elde edilen sonuçlar; 

bazı el aktivitelerinin, n. medianus’un boyutunda anlamlı değişikliklere yol açtığını ve 10-

30 dakika dinlenmenin ardından aktivite öncesi boyutuna geri döndüğünü göstermektedir 

(146). 

Palmer ve ark. tarafından yayınlanan bir literatür derlemesinde; uzun süreli ve 

yüksek tekrarlı fleksiyon ve ekstansiyon hareketlerinin, özellikle güçlü kavrama gerektiren 

durumlarda KTS riskini büyük ölçüde artırdığına dair önemli kanıtlar sunulmuştur. Aynı 

derlemede elde tutulan titreşimli aletlerin düzenli ve uzun süreli kullanımının KTS riskini 

iki kat artırdığı ortaya konulmuştur (147). 

Bland ve ark. vaka serisi incelemesinde KTS’nin ilk olarak dominant elde ortaya 

çıktığı, daha sonra bilateral özellik gösterdiği belirtilmiştir. Aynı çalışmada vakaların 

yalnızca %14’ünde dominant olmayan elde KTS bulguları olduğu bildirilmiştir (148). 

Bizim çalışmamızda elde edilen verilerin lateralizasyona göre karşılaştırılması 

incelendiğinde; hem el ve el bileğinin antropometrik ölçümleri açısından hem de canalis 

carpi’ye ait oran hesaplamaları açısından sağ ve sol taraf arasında anlamlı bir fark 

bulunmamıştır. 

Canalis carpi içerisindeki değişikliklerden en çok etkilenen yapı n. medianus’tur. 

Karpal tünel sendromundaki en hassas morfolojik değişikliklerden biri özellikle kanalın 

proksimal seviyesinde n. medianus’ta ortaya çıkan genişlemedir. Bu nedenle n. 

medianus’un enine kesit alanı KTS’nin tanısında önemli bir objektif bulgudur (149). 

Literatürde n. medianus’un boyutlarının eşik değeri konusunda bir fikir birliği 

olmadığı görülmektedir. Peetrons ve ark. sinirin enine kesit alanının normal sınırının 8-12 

mm² olarak kabul edildiğini söylemiştir (150). Bir başka çalışmada; canalis carpi’nin 

proksimal seviyesinde n. medianus’un kesit alanı ölçülmüştür ve 10.03 mm²nin üzerindeki 

değerler KTS için önemli bir ölçüt olarak kabul edilmiştir (151). 

Yao ve ark. KTS tanısı almış 11 hasta ile yaptıkları çalışmada dört hafta süreyle el 

bileğine radioulnar yönde kompresyon kuvveti uygulamış; n. medianus’u canalis carpi’nin 

distal seviyesinde US ile görüntülemişlerdir. Elde ettikleri US görüntülerinde n. 

medianus’un enine kesit alanını ImageJ programında analiz ederek; uygulanan kuvvet ile 

sinirin enine kesit alanında artış meydana geldiğini bulmuşlardır (152).  
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Loh ve ark. sağlıklı erkek katılımcılar ile yaptıkları çalışmada; farklı el bileği 

postürlerinde n. medianus’un enine kesit alanını incelemiş, US ile elde ettikleri verileri 

genç ve yaşlı bireyler arasında karşılaştırmışlardır. Çalışmada n. medianus’un enine kesit 

alanının yaşlı grupta genç gruba göre anlamlı derecede daha yüksek olduğu bulunmuştur 

(153). Çalışmamızda fetus kadavralarında, n. medianus’un enine kesit alanının canalis 

carpi içerisinde kapladığı alan yüzde olarak belirlenmiştir (NM/CC). Elde ettiğimiz 

verilerin sonucunda NM/CC oranlarının cinsiyete, NTD varlığına, intrauterin yaşa ve 

lateralizasyona göre anlamlı derecede farklı olmadığı görülmüştür. 

Bu çalışma, fetus kadavralarında el ve el bileğinin antropometrik özellikleri ile 

canalis carpi ve içeriğini oluşturan yapıların enine kesit alanlarını inceleyen ilk çalışmadır. 

Çalışmamızda, canalis carpi’nin içeriğini oluşturan yapıların kanal içerisinde kapladıkları 

alanın kadın fetuslarda anlamlı düzeyde daha küçük olduğu görülmüştür. Buna paralel 

olarak canalis carpi’nin içerdiği yapılar dışında kalan boş alanın ise kadın fetuslarda 

anlamlı derecede daha büyük olduğu ortaya çıkmıştır. Elde ettiğimiz bu sonuçlar; canalis 

carpi anatomisindeki bu farklılığın, KTS prevalansının cinsiyetler arasında değişiklik 

göstermesine katkıda bulunabileceği teorisini desteklemektedir.  

Çalışmamızda elde edilen veriler, canalis carpi’nin kesitsel anatomisinin sağ ve sol 

taraf arasında anlamlı derecede farklılık göstermediğini ortaya koymuştur. El ve el 

bileğinin tekrarlı aktivitelerinin özellikle dominant elde KTS’ye neden olduğu ve KTS’nin 

bir aşırı kullanım sendromu olarak tanımlandığı bilinmektedir. Çalışmamızda çevresel 

faktörlere maruz kalmayan fetus kadavralarının canalis carpi’leri incelenmiştir. Sağ ve sol 

taraf arasında anlamlı fark göstermeyen sonuçlarımız; tekrarlı aktivitelerin ve el 

dominansının canalis carpi, n. medianus ve fleksor tendonlarda morfolojik değişikliklere 

neden olarak KTS gelişiminde rol oynadığı teorisini desteklemektedir.  

Canalis carpi, içerisinde çok sayıda yapı bulunduran kapalı bir kompartmandır. 

Nervus medianus’un bu kapalı kompartman içinde kronik kompresyona uğraması KTS’ye 

neden olur. Bu nedenle sinirin sıkışma olasılığını belirlemek için canalis carpi’nin, n. 

medianus’un ve fleksor tendonların enine kesit alanlarının bilinmesinin; hastalığın 

etiyolojisini belirlemede ve tedavi seçeneklerini geliştirmede önemli olduğunu 

düşünmekteyiz.  
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